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Preface

How to Use This Guide

About the System  The guides listed below are shipped with the Applied Biosystems 7500/7500 Fast

Documentation

Real-Time PCR System

Time PCR System Site Preparation Guide

7500/7500 Fast system.

Intended for personnel who schedule, manage, and perform the
tasks required to prepare your site for installation of the
7500/7500 Fast system.

Guide Purpose and Audience PN
Applied Biosystems 7500/7500 Fast Real- | Explains how to perform experiments on the 7500/7500 Fast 4387784
Time PCR System Getting Started Guide system. Each Getting Started Guide functions as both a:
for Genotyping Experiments e Tutorial, using example experiment data provided with the
Applied Biosystems 7500/7500 Fast Real- gpﬁ“ed B';’g%gtemff 7500/7500 Fast Real-Time PCR 4387785
Time PCR System Getting Started Guide ottware ( SO ware)..
for Presence/Absence Experiments e Guide for your own experiments.
. ; Intended for laboratory staff and principal investigators who
Applied Biosystems 7500/7500 Fast Real- . ; 4387783
Time PCR System Getting Started Guide perform experiments using the 7500/7500 Fast system.
for Relative Standard Curve and
Comparative Cy Experiments
Applied Biosystems 7500/7500 Fast Real- 4387779
Time PCR System Getting Started Guide
for Standard Curve Experiments
Applied Biosystems 7500/7500 Fast Real- | Explains how to maintain the 7500/7500 Fast system. 4387777
Time PCR System Maintenance Guide Intended for laboratory staff responsible for the maintenance of
Applied Biosystems 7500/7500 Fast Real- | the 7500/7500 Fast system. 4387778
Time PCR System Computer Setup Guide
Applied Biosystems Real-Time PCR Provides information about the reagents you can use on 4387787
Systems Reagent Guide Applied Biosystems Real-Time PCR Systems, including:
¢ Anintroduction to TagMan® and SYBR® Green reagents
¢ Descriptions and design guidelines for the following
experiment types:
— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments
Intended for laboratory staff and principal investigators who
perform experiments using the 7500/7500 Fast system.
Applied Biosystems 7500/7500 Fast Real- | Explains how to prepare your site to receive and install the 4387776

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve

Experiments
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Preface
How to Use This Guide

Guide Purpose and Audience PN

Applied Biosystems 7500/7500 Fast Real- | Explains how to use the 7500 software to: NA

Time PCR Software v2.0 Help e Set up, run, and analyze experiments using the 7500/7500

Fast system.
e Calibrate a 7500/7500 Fast instrument.

¢ Verify that the performance of a 7500/7500 Fast instrument
with an RNase P run.

Intended for:

* Laboratory staff and principal investigators who perform
experiments using the 7500/7500 Fast system.

e Laboratory staff responsible for the installation and
maintenance of the 7500/7500 Fast system.

Assumptions This guide assumes that you:
* Are familiar with the Microsoft Windows® operating system.
* Are familiar with the Internet and Internet browsers.
* Know how to handle DNA and/or RNA samples and prepare them for PCR.
» Understand data storage, file transfer, and copying and pasting.

* Have networking experience, if you plan to integrate the 7500/7500 Fast system
into your existing laboratory data flow.

Text Conventions  This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

* [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open.

User Attention  Two user attention words appear in Applied Biosystems user documentation. Each word
Words implies a particular level of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use of
the product.

IMPORTANT! Provides information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need a valid user ID.

viii Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Preface
How to Obtain More Information

Safety Alert  Safety alert words also appear in user documentation. For more information, see “Safety
Words  Alert Words” on page xii.

How to Obtain More Information

Related Documents Related to Genotyping Experiments
Documentation

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204

Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick 4371394
Reference Card

Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates 4367636
Quick Reference Card

Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856

Documents Related to Presence/Absence Experiments

Document PN
DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal 4343586
Swabs Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol

Documents Related to Relative Standard Curve and Comparative C; Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve ix
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Preface
How to Obtain More Information

Documents Related to Standard Curve Experiments

for Experimental Studies Application Note

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Custom TaqgMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Documents Related to the Reagent Guide
Document PN
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TaqgMan® Genomic Assays Protocol: Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® Exogenous Internal Positive Control Reagents Protocol 4308335
TagMan® Fast Universal PCR Master Mix (2X) Protocol 4351891
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® Genotyping Master Mix Protocol 4371131
TagMan® SNP Genotyping Assays Protocol 4332856
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous Control 127AP08

Note: For more documentation, see “Customer and technical support” on page xi.

X Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Preface
Customer and technical support

Obtaining The 7500 Software Help describes how to use each feature of the user interface. Open
Information from the Help from within the software by doing one of the following:
the Software Help « Press F1.
* Click @ in the toolbar.
+ Select Help » 7500 Software Help.

To find topics of interest in the Help:
* Review the table of contents.
+ Search for a specific topic.

» Search an alphabetized index.

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:
* Worldwide contact telephone numbers
* Product support, including:
— Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
* Order and web support
* Product documentation, including:
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve Xi
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Safety Conventions Used in This Document

Safety Conventions Used in This Document

Xii

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—-IMPORTANT, CAUTION, WARNING, DANGER-implies a particular level of
observation or action, as defined below:

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

A (O.\I[e]\] - Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

A WWLGIIINel — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A prNel35] — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is to be limited to the most
extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard icons that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xiii).

Examples

The following examples show the use of safety alert words:

IMPORTANT! Wear powder-free gloves when you handle the halogen lamp.

ACAUTION The lamp is extremely hot. Do not touch the lamp until it has cooled to

room temperature.

AWARNING CHEMICAL HAZARD. Ethanol is a flammable liquid and vapor.

Exposure causes eye, skin, and respiratory tract irritation and may cause central nervous
system depression and liver damage. Read the MSDS, and follow the handling instructions.
Wear appropriate protective eyewear, clothing, and gloves.

A L1338 ELECTRICAL HAZARD. Failure to ground the instrument properly

can lead to an electrical shock. Ground the instrument according to the provided instructions.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Preface
Symbols on Instruments

Electrical The following table describes the electrical symbols that may be displayed on
Symbols on  Applied Biosystems instruments.
Instruments
Symbol Description Symbol Description
Indicates the On position of the I Indicates a terminal that may be
main power switch. pr connected to the signal ground
= reference of another instrument.
This is not a protected ground
terminal.
Indicates the Off position of the Indicates a protective grounding
main power switch. terminal that must be connected
to earth ground before any other
electrical connections are made
to the instrument.
Indicates a standby switch by Indicates a terminal that can
l which the instrument is switched —~ receive or supply alternating
on to the Standby condition. current or voltage.
Hazardous voltage may be
present if this switch is on
standby.
Indicates the On/Off position of a - Indicates a terminal that can
push-push main power switch. e receive or supply alternating or
direct current or voltage.
Safety Symbols The following table describes the safety symbols that may be displayed on

Applied Biosystems instruments. Each symbol may appear by itself or in combination
with text that explains the relevant hazard (see “Safety Labels on Instruments” on

page xiv). These safety symbols may also appear next to DANGERS, WARNINGS, and
CAUTIONS that occur in the text of this and other product-support documents.

Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with

Indicates the presence of a hot surface or other high-temperature hazard and
to proceed with appropriate caution.

a4

appropriate caution.

caution.

Indicates the presence of a laser inside the instrument and to proceed with

Indicates the presence of moving parts and to proceed with appropriate

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Safety Labels on Instruments

Environmental
Symbols on
Instruments

The following symbol applies to all Applied Biosystems electrical and electronic
products placed on the European market after August 13, 2005.

Symbol Description
Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
T, environmental impact of waste electrical and electronic equipment (WEEE).
\ N I European Union customers:
Call your local Applied Biosystems Customer Service office for equipment
—@ pick-up and recycling. See www.thermofisher.com for a list of customer
service offices in the European Union.
[

Safety Labels on Instruments

Xiv

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the
preceding section.

English

Francais

CAUTION Hazardous chemicals. Read the
Material Safety Data Sheets (MSDSs) before
handling.

ATTENTION Produits chimiques dangeureux.
Lire les fiches techniques de sireté de
matériels avant la manipulation des produits.

CAUTION Hazardous waste. Refer to
MSDS(s) and local regulations for handling
and disposal.

ATTENTION Déchets dangereux. Lire les
fiches techniques de sireté de matériels et la
régulation locale associées a la manipulation
et I'élimination des déchets.

WARNING Hot lamp.

AVERTISSEMENT Lampe brilante.

WARNING Hot. Replace lamp with an
Applied Biosystems lamp.

CAUTION Hot surface.

AVERTISSEMENT Composants br(lants.
Remplacer la lampe par une lampe
Applied Biosystems.

ATTENTION Surface brilante.

DANGER High voltage.

DANGER Haute tension.

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.
Refer servicing to Applied Biosystems
qualified service personnel.

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite I'utilisation d'outils.
L'instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

CAUTION Moving parts.

ATTENTION Parties mobiles.

WARNING This instrument is designed for
12V, 75 W Halogen lamps only.

AVERTISSEMENT Cet instrument est congu
pour des lampes d'halogene de 12 Vet 75 W
seulement.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Locations of

Warnings the locations shown below.

Preface
Safety Labels on Instruments

The Applied Biosystems 7500/7500 Fast Real-Time PCR System contains warnings at

-

A Attention
& Physical hazard

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve XV
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General Instrument Safety

General Instrument Safety

AWARNING PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and ACAUTION PHYSICAL INJURY HAZARD. The instrument is to be moved

Lifting the and positioned only by the personnel or vendor specified in the applicable site
Instrument preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

Moving and AWARNING Do not attempt to lift or move the computer or the monitor without

Lifting Stand-  the assistance of others. Depending on the weight of the computer and/or the monitor,
Alone Computers moving them may require two or more people.
and Monitors

Things to consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

* Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.

» Keep your spine in a good neutral position while lifting with your legs.

* Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the Ensure that anyone who operates the instrument has:

Instrument * Received instructions in both general safety practices for laboratories and specific

safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See “4L
Reagent and Waste Bottle Safety. Four-liter reagent and wastebottles can crack and
leak. Each 4-liter bottle should be secured in a low-density polyethylene safety
container with the cover fastened and the handles locked in the upright position.” on
page Xxvii.

AWARNING PHYSICAL INJURY HAZARD. Use this instrument as specified

by Applied Biosystems. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

XVi Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Chemical Safety

Cleaning or A (oZ\{eo)\] Before using a cleaning or decontamination method other than those

Decontaminating recommended by the manufacturer, verify with the manufacturer that the proposed
the Instrument  method will not damage the equipment.

Chemical Safety

Chemical Hazard AWARNING GENERAL CHEMICAL HANDLING. To minimize

Warning hazards,ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant SDS for
specific precautions and instructions:-

Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. To obtain SDSs, see the “Documentation and Support” section in this
document.

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers open.Use
only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, followthe
manufacturer's cleanup procedures as recommended in the SDS.

Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

After emptying a waste container, seal it with the cap provided.

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of according
to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

A WWZ:GUTIed HAZARDOUS WASTE (from instruments). Waste produced by the

instrument is potentially hazardous. Follow the guidelines noted in the preceding
General Chemical Handling warning.

AWARNING 4L Reagent and Waste Bottle Safety. Four-liter reagent and

wastebottles can crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve Xvii
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Chemical Safety

Biological hazard

safety
AWARNING Potential Biohazard. Depending on the samples used on this

Xviii

instrument, the surface may be considered a biohazard. Use appropriate decontamination
methods when working with biohazards..

AWARNING BIOHAZARD. Biological samples such as tissues, body

fluids,infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. All work should be conducted in properly equipped
facilities using the appropriate safety equipment (for example, physical containment
devices). Safety equipment also may include items for personal protection, such as
gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should betrained according to applicable regulatory and company/
institution requirements before working with potentially biohazardous materials. Follow
all applicable local, state/provincial, and/or national regulations. The following
references provide general guidelines when handling biological samples inlaboratory
environment.

* U.S. Department of Health and Human Services, Biosafety in Microbiological and
Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)21-
1112, Revised December 2009; found
at:www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

* World Health Organization, Laboratory Biosafety Manual, 3rd
Edition, WHO/CDS/CSR/LY0/2004.11; found
at:www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Electrical Safety

Electrical Safety

A PEW[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can
result from operating the Applied Biosystems 7500/7500 Fast Real-Time PCR System
without its instrument panels in place. Do not remove instrument panels. High-voltage
contacts are exposed when instrument panels are removed from the instrument.

Fuses AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

Power A PEW[el35] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A PEW[e]33] ELECTRICAL HAZARD. Use properly configured and approved
line cords for the voltage supply in your facility.

A PEW[e]33] ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

Overvoltage The Applied Biosystems 7500/7500 Fast Real-Time PCR System has an installation
Rating (overvoltage) category of 11, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts éWARNING PHYSICAL INJURY HAZARD. Moving parts can crush and cut.

Keep hands clear of moving parts while operating the instrument. Disconnect power
before servicing the instrument.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve Xix
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Workstation Safety

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

ACAUTION MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.

XX Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Safety and Electromagnetic Compatibility (EMC) Standards

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and
Canadian Safety
Standards

c(UL)us

Canadian EMC
Standard

European Safety
and EMC
Standards

C€

Australian EMC
Standards

C

This section provides information on:
* U.S. and Canadian Safety Standards
* Canadian EMC Standard
* European Safety and EMC Standards
* Australian EMC Standards

This instrument has been tested to and complies with standard UL 61010A-1, “Safety
Requirements for Electrical Equipment for Laboratory Use, Part 1: General
Requirements” and with standard UL 61010-2-010, “Particular Requirements for
Laboratory Equipment for the Heating of Materials.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use,
Part 1: General Requirements.”

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial,
Scientific, and Medical Radio Frequency Generators.

Safety

This instrument meets European requirements for safety (Low Voltage Directive
2006/95/EC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular
Requirements for Laboratory Equipment for the Heating of Materials,” and with
standard EN 61010-2-081:2002+A1:2003 “Particular Requirements for Automatic and
Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve XXi
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n Get Started

This chapter covers:

B About the 7500/7500 Fast System .. ..., 2
B Supported Consumables . . ............ i 4
B About Standard Curve Experiments. .. ..............vuitvininrnnnenen... 7
B HowtoUseThisGuide ......... ... 11
B About the Example Standard Curve Experiment .. ........................ 12
B Example Experiment Workflow . ........ ... .. ... ... ... ... . . . 14

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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About the 7500/7500 Fast System

The Applied Biosystems 7500/7500 Fast Real-Time PCR System is a 96-well, five-color
platform that uses fluorescence-based polymerase chain reaction (PCR) reagents to provide:

* Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs
post-PCR).

About Data The 7500/7500 Fast system collects raw fluorescence data at different points during a
Collection PCR, depending on the type of run that the instrument performs:

Run Type Data Collection Point

Real-time runs | Standard curve The instrument collects data after each extension
step of the PCR.

Relative standard curve

Comparative C; (AACy)
Post-PCR Genotyping The instrument collects data:
(endpoint) runs Presence/absence e Before the PCR (For presence/absence

experiments, data collection before the PCR is
optional but recommended.)

e (Optional) During the PCR. The instrument can
collect data during the run (real-time);
collecting data during the run can be helpful
for troubleshooting.

e After the PCR.

Regardless of the run type, a data collection point or read on the 7500/7500 Fast
instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The 7500 software stores the raw
fluorescence image for analysis.

After a run, the 7500 software uses region of interest (ROI), optical, dye, and background
calibrations to determine the location and intensity of the fluorescence in each read, the
dye associated with each fluorescent signal, and the significance of the signals.

Notes
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About the Filters The 7500/7500 Fast system uses the following filters:

Filter 1 2 3 4 S
e FAM™ dye e JOE™dye ¢ TAMRA™dye | ® ROX™dye | Cy5®dye
Dye e SYBR®Green | o VIC®dye | e NED"dye ¢ Texas Red®
dye e Cy3®dye dye

For More For information on:

Information » The 7500/7500 Fast system — Refer to the Applied Biosystems 7500/7500 Fast Real-
Time PCR Software Help.

Note: To open the Help, select Help » 7500 Software Help in the 7500 software.

* Genotyping experiments — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR System Getting Started Guide for Genotyping Experiments.

* Presence/absence experiments — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR System Getting Started Guide for Presence/Absence Experiments.

» Relative standard curve and/or comparative C; (AACy) experiments — Refer to the
Applied Biosystems 7500/7500 Fast Real-Time PCR Systems Getting Started Guide
for Relative Standard Curve and Comparative Cy Experiments.

Notes
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Supported Consumables

7500 System  The 7500 system supports the consumables listed below.

Consumable Part Number
¢ MicroAmp® Optical 96-Well Reaction Plate with Barcode, 0.2-mL e 4306737
e MicroAmp™ Optical Adhesive Film e 4311971
¢ MicroAmp™ Optical 8-Tube Strip, 0.2-mL * 4316567
¢ MicroAmp™ Optical 8-Cap Strip e 4323032
e Microamp® Splash Free Support Base e N8010531
¢ MicroAmp™ Adhesive Film Applicator e 4333183
¢ MicroAmp® Cap Installing Tool (Handle) e 4330015
e MicroAmp™ Multi-Removal Tool e 4313950

C
E
B
# Consumable # Consumable
A | MicroAmp® Optical 96-Well Reaction Plate, E | MicroAmp™ Optical 8-Tube Strip
0.2-mL
B | Microamp® Splash Free Support Base G | MicroAmp™ Optical Adhesive Film
C | MicroAmp™ Optical 8-Cap Strip, 0.2-mL
Notes
4 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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7500 Fast System  The 7500 Fast system supports the consumables listed below.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the 7500 Fast system, even when performing an experiment with standard reagents.

Consumable Part Number
¢ MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1-mL * 4346906
¢ MicroAmp™ Optical Adhesive Film e 4311971
e MicroAmp™ Fast 8-Tube Strip, 0.1-mL e 4358293
e MicroAmp™ Optical 8-Cap Strip e 4323032
e Microamp® Splash Free Support Base e N8010531
e MicroAmp™ Adhesive Film Applicator e 4333183
e MicroAmp® Cap Installing Tool (Handle) e 4330015
¢ MicroAmp™ Multi-Removal Tool e 4313950

# Consumable
A | MicroAmp™ Fast Optical 96-Well Reaction Plate, 0.1-mL
B | Microamp® Splash Free Support Base
C | MicroAmp™ Optical 8-Cap Strip
| D | MicroAmp™ Fast 8-Tube Strip
E | MicroAmp™ Optical Adhesive Film

Notes
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Supported Consumables

Standard vs.
Fast Reaction
Plates and Tubes

Notes

Make sure that you use the correct reaction plate for your system:

System

Reaction Plate

7500 system

¢ MicroAmp® Optical 96-Well Reaction Plate (PN 4306737, also called
standard reaction plates)

e MicroAmp™ Optical 8-Tube Strip, 0.2-mL (PN 4316567, also called
standard reaction tube strips)

IMPORTANT! Fast reaction plates and tubes do not fit into the standard
sample block correctly and will result in loss of data.

7500 Fast
system

e MicroAmp™ Fast Optical 96-Well Reaction Plate, (PN 4346906, also called
Fast reaction plates)

¢ MicroAmp™ Fast 8-Tube Strip, 0.1-mL (PN 4358293, also called Fast
reaction tube strips)

IMPORTANT! Standard reaction plates and tube strips will not properly
function and might be crushed when using the Fast sample block.

Al

Notch at —
top-left

corner “‘*5\ -
by A1 o
i

Fast Reaction Plates Standard Reaction Plates
(PN 4346906) (PN 4306737)

‘— Notch at top-right
.. corner by A12

ﬁf H | J '| RAE T l
10| Iqpu— i N T T N N R O 'l'|'||.||||||||'|||||||I 100-pL
|I|||||||||||||| |I||||I 9]
maximum u TR YRR YRR YRR Y YT Y maximum
reaction reaction
volume volume
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7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
Experiments



Chapter 1 Get Started n

About Standard Curve Experiments

About Standard Curve Experiments

Real-Time PCR Standard curve experiments are real-time PCR experiments. In real-time PCR
Experiments experiments:

* The instrument monitors the progress of the PCR as it occurs.

» Data are collected throughout the PCR process.

» Reactions are characterized by the point in time during cycling when amplification
of a target is first detected.

Note: In this guide, the term experiment refers to the entire process of performing a run
using the 7500/7500 Fast system, including setup, run, and analysis.

About Standard The standard curve method is used to determine the absolute target quantity in samples.
Curve With the standard curve method, the 7500 software measures amplification of the target
Experiments in samples and in a standard dilution series. Data from the standard dilution series are
used to generate the standard curve. Using the standard curve, the software interpolates
the absolute quantity of target in the samples.

Components
The following components are required when setting up PCR reactions for standard
curve experiments:

» Sample — The sample in which the quantity of the target is unknown.

* Standard — A sample that contains known standard quantities; used in quantitation
experiments to generate standard curves.

» Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative Controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

Notes
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About Standard Curve Experiments

PCR Options When performing real-time PCR, select between:
» Singleplex and multiplex PCR (below)

and
* 1-step and 2-step RT-PCR (page 8)

Singleplex vs. Multiplex PCR

You can perform a PCR reaction using either:

+ Singleplex PCR — In singleplex PCR a single primer set is present in the reaction
tube or well. Only one target or endogenous control can be amplified per reaction.

or

*  Multiplex PCR — In multiplex PCR, two or more primer sets are present in the
reaction tube or well. Each set amplifies a specific target or endogenous control.
Typically, a probe labeled with FAM™ dye detects the target and a probe labeled
with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

= o nE [ Target Primer Set

=

— 3 ©0 (O Endogenous Control
~ Primer Set

. ~~ cDNA
Singleplex PCR Multiplex PCR

1- vs. 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether you
are performing 1- or 2-step RT-PCR:

* In 1-step RT-PCR, RT and PCR take place in one buffer system, which provides the
convenience of a single-tube preparation for RT and PCR amplification. However,
you cannot use Fast PCR master mix or the carryover prevention enzyme,
AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

» 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-
transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful
for detecting multiple transcripts from a single cDNA template or for storing cDNA
aliquots for later use. The AmpErase® UNG enzyme can be used to prevent
carryover contamination.

Note: For more information on AmpErase® UNG, refer to the Applied Biosystems Real-
Time PCR Systems Reagent Guide.

Notes
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About Standard Curve Experiments

Supported TagMan® and SYBR® Green Reagents
Reagents Applied Biosystems offers TagMan® and SYBR® Green reagents for use on the
7500/7500 Fast system. Both reagent types are briefly described in the table below.
Note: If you use TagMan® or SYBR® Green reagents, the 7500 software automatically
calculates reaction volumes in the Reaction Setup screen.
Reagent Type Process
TagMan® reagents or kits PCR and Detection of cDNA
Descri ption a. Assay Components 3
.Y Probe / Reverse primer
TagMan reagents use a fluorogenic probe to Forvardprimer @@ s
enable detection of a specific PCR product as S ot P
it accumulates during PCR cycles. T T OO ;‘: — o
Advantages ’ ’
e |ncreased specn‘lmty with the addition of a b. Denatured Temp;\ate and Annealing of Assay Components .
fluorogenic probe. S e a LEEND
¢ Provides multiplex capability. . e e @ o
e Preformulated assays, optimized to run FomarPInet N\ s Q) Quencher
under universal thermal cycling conditions, s S, s Mo Goove
are avallable . c. Signal Generation AmpliTaq Gold®
¢ Can be used for either 1- or 2-step RT-PCR. s . DNA Polymerase
Limitations ’ RATITIRING \Hlm Probe
Requires synthesis of a unique fluorogenic , Fommd i Gl s o
probe. OO LI 6o AT 11 Template
3 5 Extended Primer

SYBR® Green reagents
Description

SYBR Green reagents use SYBR® Green | dye,
a double-stranded DNA binding dye, to detect

Limitations

Binds nonspecifically to all double-stranded
DNA sequences. To avoid false-positive
signals, check for nonspecific product
formation using melt curve or gel analysis.

Step 1: Reaction setup
The SYBR® Green | dye
fluoresces when bound to
double-stranded DNA.

double-stranded product,

resulting in a net increase in
fluorescence detected by the

instrument.

Step 4: Polymerization completed
SYBR® Green | dye binds to the

PCR products as they accumulate during PCR D) ° Step 2: Denaturation
cycles. ® ® When the DNA is denatured into
single-stranded DNA, the

Advantages SYBR® Green | dye is released and
e Economical (no probe needed). the fluorescence is drastically reduced.
¢ Allows for melt curve analysis to measure iy ° Step 3: Polymerization

the Tm of all PCR products. o During extension, primers
e Can be used for either 1- or 2-stepRT-PCR. | ©¢ © anneal and PCR product

® o is generated.

Notes
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About Standard Curve Experiments

Other Reagents

If you use fluorescence-based reagents other than TagMan® reagents, you must design
your experiment using Advanced Setup instead of the Design Wizard (see “Advanced
Setup Workflow” on page 98).

For More For more information on real-time PCR experiments, PCR options, and reagents, refer to
Information the Applied Biosystems Real-Time PCR Systems Reagent Guide.

Notes
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How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own
experiments.

Using This Guide By using the example experiment data provided with the 7500 software, you can use this
as a Tutorial guide as a tutorial for performing a standard curve experiment on a 7500/7500 Fast
system. Follow the procedures in Chapters 2 through 5:

Chapter Procedure
2 Design the experiment using the Design Wizard in the 7500 software.
3 Prepare the experiment, using the reagents and volumes calculated by the

Design Wizard in Chapter 2.

4 Run the experiment on a 7500/7500 Fast instrument.

5 Analyze the results.
For more information, see “About the Example Standard Curve Experiment” on page 12.

Using This Guide After completing the tutorial exercises in Chapters 2 through 5, you can use this guide to
with Your Own lead you through your own standard curve experiments. Each procedure in Chapters 2
Experiments through 5 includes a set of guidelines that you can use to perform your own experiments.

Additionally, you can use one of the other workflows provided in the 7500 software to
perform your experiments. The table below provides a summary of all the workflows
available in the 7500 software.

Workflow Description See...

Design Wizard | Set up a new experiment with guidance from the software. | Chapter 2
The Design Wizard guides you through best practices as
you create your own experiment. The Design Wizard is
recommended for new users.

Note: Design options are more limited in the Design
Wizard than in Advanced Setup.

Advanced Set up a new experiment using advanced options. page 98
Setup Advanced Setup allows design flexibility as you create
your own experiment. Advanced Setup is recommended
for experienced users.

QuickStart Run a new experiment with no plate setup information. If page 100
desired, you can add all design parameters after the run.

Template Set up a new experiment using setup information from a page 102
template.

Export/Import Import experiment designs from ASCII text files that page 104

contain experiment setup information.

Notes
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About the Example Standard Curve Experiment

Notes

12

Description

To illustrate how to perform standard curve experiments, this guide leads you through the
process of designing, preparing, running, and analyzing an example experiment. The
example experiment represents a typical setup that you can use to quickly familiarize
yourself with a 7500/7500 Fast system.

The objective of the standard curve example experiment is to determine the quantity of
the RNase P gene in two populations.

In the standard curve example experiment:

L]

The samples are genomic DNA isolated from two populations.
The target is the RNase P gene.

One standard curve is set up for the RNase P gene (target). The standard used for the
standard dilution series contains known quantities of the RNase P gene. Because a
single target is being studied, only one standard curve is required.

Note: In experiments where multiple targets are being studied, a standard curve is
required for each target.

Three replicates of each sample and each dilution point in the standard curve are
performed to ensure statistical significance.

The experiment is designed for singleplex PCR, where every well contains a
primer/probe set for a single target.

Primer/probe sets are from Applied Biosystems RNase P assay.

Note: The human RNase P FAM™ dye-labeled MGB probe is not available as a
TagMan® Gene Expression Assay. It can be ordered as a Custom TagMan® Gene
Expression Assay (PN 4331348).

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Reaction Plate The 7500 software displays the 96-well reaction plate layout as shown below:

Layout
1 2 3 4 5 1] 7 8 9 10 11 12
popi popi popi pop: pop: pop:
a D RNase . D RNase . D RNase . Rhase . Rhase . Rhase . Rhase . Rhase . Rhase . E4RNBSE 1 E4RNBSE 1 E4RNBSE 1
. THE3 2.84E3 2.81E3 531E3 5.5E3 5.54E3
D RNase'. D RNase'. D RNase'. D RNase'. D RNase'. D RNase'. D RNase'. D RNase'. D RNase'. D RNase'. D RNase'. D RNase'.
B 5ES] 5ES] 5ES] 2.5E3 2.5E3 2.5E3 1.2HE4 1.2HE4 1.2HE4 625 625 625
c
[u]
E
F
G
H
wWells: [[] 6 Unknown [5]] 15 Standard [] 3 Negative Control 72 Empty

About the In this getting started guide, you will use two files:

. Example * In Chapter 2, you will create a standard curve example experiment that contains
Experiment Data setup data, then you will save the file to your computer.

* In Chapter 5, you will view results in a standard curve example experiment file that
contains run data. The data file for the example experiment is installed with the 7500
software. You can find the data file for the example experiment on your computer at:

<drive>:\Applied Biosystems\<software name>\experiments\
Standard Curve Example.eds

where:
— <drive> is the computer hard drive on which the 7500 software is installed.

— <software name> is the current version of the 7500 software.

Notes
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Example Files in the Experiments Folder

The experiments folder of the 7500 software contains several example files that you can
reference when analyzing your own data. The following example files install with the
7500 software:

* Comparative Ct Example.eds

e Comparative Ct Study Example.edm

» Comparative Ct Study (Biological Groups).edm
* Genotyping Example.eds

* Presence Absence Example.eds

» Relative Standard Curve Example.eds

» Standard Curve Example.eds

IMPORTANT! Be sure to use the Standard Curve Example.eds file when you perform the
procedures in this guide.

Example Experiment Workflow

Start Experiment

v
Design the Experiment (Chapter 2)

Create a new experiment.

Define the experiment properties.
Define the methods and materials.
Set up the targets.

Set up the standards.

Set up the samples.

Set up the run method.

Review the reaction setup.

. Order materials for the experiment.
0.Finish the Design Wizard.

h 4
Prepare the Reactions (Chapter 3)

o © o N o o~ Db~

1. Prepare the sample dilutions.

2. Prepare the standard dilution series.

3. Prepare the reaction mix for each target assay.
4. Prepare the reaction plate.

v

(see page 15)

Notes
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Example Experiment Workflow

(see page 14)
v
Run the Experiment (Chapter 4)

Prepare for the run.
Enable the notification settings (Optional).
Start the run.

Monitor the run.

S A

Unload the instrument and transfer the data.

v

Analyze the Experiment (Chapter 5)
Section 1, Review Results:
. Analyze.
. View the standard curve.
. View the amplification plot.
. View the results in a table.
. Publish the data.
Section 2, Review Multiple Experiments Results:

a b WO N =

. Create a study.

. Define replicates.

. Analyze.

. View the gene expression data.

. View the experiment data.

View the multicomponent data.

. View multiple plots.

. View the quality summary.

. Publish the data.

Section 3, Troubleshoot (If Needed):
1. View the analysis settings; adjust the baseline/threshold.

© O N O U W N 2

. View the quality summary.
. Omit wells.

. View the multicomponent plot.

a A~ W N

. View the raw data plot.

v
End Experiment

Notes
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Example Experiment Workflow

Notes
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n Design the Standard Curve
Experiment

This chapter covers:

B Chapter OVerVIBW . . . ottt ettt e e e e e et e ettt 18
B Createa New Experiment. .. ........... it 19
B Define the Experiment Properties. . . .......... ... . i 20
B Define the Methods and Materials . ... ........ ... ... . .o, 22
B SetUpthe Targets. . ... ..ottt e e e 24
B SetUpthe Standards. . ........ ... ... i 26
B SetUptheSamples. . ... e 28
B SetUptheRunMethod ........... .. .. . . . i, 30
B Review the Reaction Setup. . ........... i 32
B Order Materials for the Experiment . .. ............ ... .. .0iiiininan.. 37
B Finishthe Design Wizard . . ...... ... .. i 40

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

This chapter explains how to use the Design Wizard in the 7500 software to set up the
standard curve example experiment. The Design Wizard guides you through Applied
Biosystems recommended best practices as you enter design parameters for the example
experiment.

Note: When you design your own experiments, you can select alternate workflows (see
“Using This Guide with Your Own Experiments” on page 11).

Example Start Experiment
Experiment v
Workflow

Design the Experiment (Chapter 2)
. Create a new experiment.
. Define the experiment properties.
. Define the methods and materials.
. Set up the targets.
. Set up the standards.

. Set up the run method.
. Review the reaction setup.

. Order materials for the experiment.

1
2
3
4
5
6. Set up the samples.
7
8
9
1

0. Finish the Design Wizard.

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v

End Experiment

Notes
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Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the 7500 software:

Create an 1. Double-click g (7500 software) or select Start » All Programs » Applied
Experiment Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. In the Home screen, click | [\ | Design Wizard to open the Design Wizard.

Fils Edit_Insiument_Analysis _Tools _Help
(& NewExperiment + (25 Open.. [ Save ~ BN Close | @ Export. - B PrintReport

Analyze

Design Wizard QuickStart Analyze Experiment

'vr]lb,

Advanced Setup Create Study

= [¢

A Home

Notes
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Define the Experiment Properties

In the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

About the In the standard curve example experiment:
£ Exa_lmplci * The experiment is identified as an example.
Xperimen » The instrument that is selected to run the experiment is the 7500 instrument.
+ A MicroAmp® Optical 96-Well Reaction Plate is used.
» The experiment type is quantitation.
Complete the 1. Click the Experiment Name ficld, then enter Standard Curve Example.
Experiment
Properties Screen Note: The experiment header is updated with the experiment name you entered.
2. Leave the Barcode field empty.
3. Click the User Name field, then enter Example User.
4. Click the Comments field, then enter Standard Curve Getting Started Guide
Example.
5. Select 7500 (96 Wells).
6. Select Quantitation for the experiment type.
7. Click Next.
1A. Define: Experiment Properties Experiment Properties Help @

Notes

A OODN =

u Instructions: Enter an experiment name, select the instrument type, then select the type of experiment to design

How do you want to identify this experiment? = Required

Capeniien vane

| Standard Curve Example |

v (opiuai. | Example User |

S ‘ tandard Curve Getting Started Guide Example| [

Which instrument are you using to run the experiment?

[

|
|

Setup, run, and analyze an experiment using a 4- or 5-color, 96-well system.

What type of experiment do you want to design?

f

[

< Quantitation ] [ Genotyping } [ Presence / Absence ]

Design a gene quantitation experiment to determine the amount oftarget nucleic acid sequence in a sample

20
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Design  When you design your own standard curve experiment, you:

Guidelines » Enter an experiment name that is descriptive and easy to remember. You can enter
up to 100 characters in the Experiment Name field. You cannot use the following
characters in the Experiment Name field: /\><*?"|:;

Note: The experiment name is used as the default file name.

* (Optional) Enter a barcode to identify the barcode on the reaction plate. You can
enter up to 100 characters in the Barcode field.

* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.

* (Optional) Enter comments to describe the experiment. You can enter up to 1000
characters in the Comments field.

* Select the instrument you are using to run the experiment:
— 7500 (96 Wells)
— 7500 Fast (96 Wells)

Note: You can use 7500 software v2.0 to design experiments for the 7500/7500 Fast
instrument.

Note: To set the default instrument type, select Tools » Preferences, then select the
Defaults tab (default). In the Default Instrument Type drop-down list, select the
appropriate instrument.

X

%) preferences

: Defaults | Startup

u Enter a default sample valume for your experiments, selectyour default falders, and
selectthe type of instrument for the software to use by default

Sample Reaction Vol | 50 WL

Data Folder: CMpplied Biosystems\7500\experiments ‘ Browse

Impart Folder: CMpplied Biosystems\7500iexperimenis ‘ Browse

Export Folder: CMpplied Biosystems\7500\experiments ‘ Browse

Instrument Type 7500 -

oK ‘ | Cancel |

For More For more information on:
Information * Completing the Experiment Properties screen — Open the 7500 Software Help by
clicking @) or pressing F1.
* Consumables — See “Supported Consumables” on page 4.

* Quantitation experiments — Refer to the Applied Biosystems Real-Time PCR
Systems Reagent Guide.

Notes
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Define the Methods and Materials

About the
Example
Experiment

Complete the
Methods &
Materials Screen

In the Methods & Materials screen, select the quantitation method, reagents, ramp speed,
and PCR template to use for the experiment.

In the standard curve example experiment:
* The standard curve quantitation method is used.
+ TagMan® reagents are used.
* The standard ramp speed is used in the instrument run.

* Purified gDNA (isolated from two populations) is the template type. You must first
extract the gDNA from tissue or sample.

1. Select Standard Curve as the quantitation method.

. Select TagMan® Reagents for the reagents.

2
3. Select Standard (~ 2 hours to complete a run) for the ramp speed.
4. Select gDNA (genomic DNA) for the template type.

5

. Click Next.

1B. Define: Methods & Materials Methocls & Materials Help @)

a Instructions: Selectthe quantitation method, reagents, ramp speed, and type of template for the real-time PCR reactions.

Which guantitation method are you using?

1 [ + Standard Curve ] [ Relative Standard Curve ] [ Comparative CT (AACT) ]

With the standard curve method, you use standards to determine the absolute quantity oftarget sequence in a sample.

2 L J TagMan® Reagents ] [ SYBR® Green Reagents ]

L

Which reagents do you want to use to detect the target sequence?

These real-time PCR reactions contain two primers and a TagMan® probe. The primers are designed to amplify the target sequence. The TagMan probe is designed to hybridize to the
targst sequence and generate fluorescence signal when the target sequence is amplifisd

Which ramp speed do you want to include in the instrument run?

3 [..' Standard (~ 2 hours to complete a run)]

For optimal results using the standard ramp speed, Applied Biosystems recommends standard reagents for your real-time PCR reactions.

What type of template do you want to use in the real-time PCR reactions?

[

cDNA (complementary DMNA) ] [ RMA ] [ + gDNA (genomic DMNA) }

oi

u are adding purified gDMA to the real-time PCR reactions. You have already extracted the gDNA from tissue or s imple.

Notes
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Design  When you design your own standard curve experiment:

Guidelines * Select Standard Curve as the quantitation method. The standard curve method is
q
used to determine the absolute target quantity in samples. When setting up your
reaction plate, the standard curve method requires targets, standards, and samples.

» Select the reagents you want to use:

— Select TagMan® Reagents if you want to use TagMan reagents to detect
amplification and quantify the amount of target in the samples. TagMan reagents
consist of two primers and a TagMan® probe. The primers are designed to amplify
the target. The TagMan probe is designed to hybridize to the target and generate
fluorescence when the target is amplified.

— Select SYBR® Green Reagents if you want to use SYBR Green reagents to detect
amplification and quantify the amount of target in the samples. SYBR Green
reagents consist of two primers and SYBR® Green dye. The primers are designed to
amplify the target. The SYBR Green dye generates fluorescence when it binds to
double-stranded DNA. SYBR Green dye is often part of the SYBR Green master
mix added to the reaction. If you use SYBR Green dye, select the Include Melt
Curve check box to perform melt curve analysis of the amplified target.

Note: Although you can use other fluorescence-based reagents on the 7500/7500 Fast
system, you must design your experiment using Advanced Setup instead of the Design
Wizard.

* Select the appropriate ramp speed for the instrument run:
— Select Fast (~ 40 minutes to complete a run) if you are using Fast reagents for
the PCR reactions.
— Select Standard (~ 2 hours to complete a run) if you are using standard
reagents for the PCR reactions.
* Select the appropriate PCR template:

— Select cDNA (complementary DNA) if you are performing 2-step RT-PCR, and
you have already performed reverse transcription to convert the RNA to cDNA.
You are adding complementary DNA to the PCR reactions.

— Select RNA if you are performing 1-step RT-PCR. You are adding total RNA or
mRNA to the PCR reactions.

Note: To use the Fast ramp speed with RNA templates, you must design your
experiment using Advanced Setup instead of the Design Wizard.

— Select gDNA (genomic DNA) if you have already extracted the gDNA from
tissue or sample. You are adding purified genomic DNA to the PCR reactions.

Notes
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For More For more information on:

Information * Completing the Methods & Materials screen — Open the 7500 Software Help by
clicking ) or pressing F1.
» Using Advanced Setup — See “Advanced Setup Workflow” on page 98.

» Using other quantitation methods — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR Systems Getting Started Guide for Relative Standard Curve and
Comparative CyExperiments.

* TagMan and SYBR Green reagents — Refer to the Applied Biosystems Real-Time
PCR Systems Reagent Guide.

* PCR, including singleplex vs. multiplex PCR and 1-step vs. 2-step RT PCR — Refer
to the Applied Biosystems Real-Time PCR Systems Reagent Guide.

Set Up the Targets

In the Targets screen, you enter the number of targets you want to quantify in the PCR
reaction plate, then set up the experiments for each target.

About the In the standard curve example experiment:

Example * One target is quantified in the reaction plate.

Experiment * The Set Up Standards check box is selected. When this check box is selected, the
software automatically displays the Standards screen after you complete the Targets
screen. In the Standards screen, you can set up a standard curve for the target
experiment (see “Set Up the Standards” on page 26).

* The Target 1 experiment is set up for the target you are studying. For the example
experiment, the target is the RNase P gene.

Complete the 1. Click the How many targets do you want to quantify in the reaction plate? field,
Targets Screen then enter 1.

Note: The number of rows in the targets table is updated with the number you
entered.

2. Select the Set Up Standards check box to set up standards for the target
experiment.

Note: The Set Up Standards check box is selected by default.
3. Set up the Target 1 experiment:

a. Click the Enter Target Name cell, then enter RNase P TAMRA.
b. In the Reporter drop-down list, select FAM (default).

c. In the Quencher drop-down list, select TAMRA.
d. In the Color field, leave the default.
Notes
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Set Up the Targets

4. Click Next.

Note: Leave blank the (Optional) Enter Gene Name field. You can search for the gene/assay
ID when you order your materials (see “Order Materials for the Experiment” on page 37).

2A. Set Up: Targels Targets Help @

u Instructions: Enter the number of targets to quantify in the reaction plate, then set up the assay for each target

Set Up Targets = Required

7 1

1 + How many targets do you wantto quantify in the reaction plate !

For each target assay in the reaction plate, select whether to set up standards, enter a target name, selectthe reporter and gquencher to use to detect the target, and select a target colar

. (Optional) Enter a gene name, find Applied Biosystems gene expression assays, then select an assay to fill in the Assay 1D

Set Up Standar, * Enter Target Mame Reporter Quencher Color | Assay D (Optionaly Enter Gene Mame and Click"Fi...
2 ‘ RMase P TAMRA ‘FAM v [TAMRA vl%" |~ Find
@ | \ ‘ m | | |
3a 3b 3c 3d

Design  When you design your own standard curve experiment:

Guidelines * Select the Set Up Standards check box. Applied Biosystems recommends that you
set up a standard curve for each target experiment in the reaction plate.

* Identify each target experiment with a unique name and color. You can enter up to
100 characters in the Target Name field.

» Select the reporter dye used in the target experiment. In the Methods & Materials
screen on page 22, if you selected:

— TagMan® Reagents — Select the dye attached to the 5" end of the TagMan probe.
— SYBR® Green Reagents — Select SYBR.

» Select the quencher used in the target experiment. In the Methods & Materials
screen on page 22, if you selected:

— TaqMan® Reagents — Select the quencher attached to the 3" end of the TagMan
probe.

— SYBR® Green Reagents — Select None.

For More For more information on completing the Targets screen, open the 7500 Software Help by
Information  clicking @) or pressing F1.

Notes
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Set Up the Standards

Set Up the Standards

In the Standards screen, enter the number of points and replicates for all standard curves
in the reaction plate. For each standard curve, enter the starting quantity and select the
serial factor.

About the
Example
Experiment

Complete the
Standards Screen

2B. Set Up: Standards

In the standard curve example experiment:

One standard curve is set up for the target (RNase P). The standard used for the
standard dilution series contains known quantities of the RNase P gene. Because a
single gene is being studied, only one standard curve is required.

Five points are used in the standard curve.

Three replicates are used for each point. Replicates are identical reactions,
containing identical reaction components and volumes.

The starting quantity is 10,000 copies, and the serial factor is 1:2.

Click the How many points do you need for each standard curve? field, then
enter S.

Click the How many replicates do you need for each point? field, then enter 3.

Define the range of standard quantities for the RNase P experiment:
a. Click the Enter Starting Quantity field, then enter 10000.

b. In the Select Serial Factor drop-down list, select 1:2.

Review the Standard Curve Preview pane. The standard curve has the following
points: 10000, 5000, 2500, 1250, and 625.

Click Next.

Standards Help €3

a Instructions: ENterthe number of points and replicates for all standard curves in the reaction plate. For each standard curve, enter the starting quantity and selectthe serial factor

Set Up Standards = Required i View Plate Layout
>
1 *How many points do you need for each standard curve? E Arrange Plate by: |Rows - Place Megative Controls in: |[Upper Left  »
* How many replicates do you need for each point? 3 . B
2 D Show inWells v ViewLegend
For each standard curve, define the range of standard guantities by entering the starting
3a guantity and serial factor, 1" [z [ 3 a5 e[ 7 &89 101 [1z]
Define the standard curve so thatthy range of standard quantities spans the expected R R B SRR =SS (SR | SRR (SR LEam R. R R.
range of quantities for the unknowns B D D D B m 7 [ m 7 B R g‘ @‘ @A
Target Name Enter Starting Quantity Select Serial Factor [
[ R R R R R R R R R R R R
e oS |- N—] =M ReiElEledt e e el de e
3b J N
Standard Curve Preview g o]
Standard Curve Preview for 0 RNase P TAMRA N
4 E
F
G
H
m 6 - Unknown B 15 - Standard DE - Negative Control 72 - Empty
Notes
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Design  When you design your own standard curve experiment:

Guidelines » Set up a standard curve for each target in the reaction plate. The targets are
previously defined on the Targets screen (“Set Up the Targets” on page 24).

* Enter the number of points for each standard curve in the reaction plate. Applied
Biosystems recommends at least five dilution points for each standard curve.

» Enter the number of replicates (identical reactions) for each point in the standard
curve. Applied Biosystems recommends three replicates for each point.

* Because the range of standard quantities affects the amplification efficiency
calculations, carefully consider the appropriate range of standard quantities for your
assay:

— For more accurate measurements of amplification efficiency, use a broad range of
standard quantities, such as between 10° and 10°. If you specify a broad range of
quantities for the standards, you need to use a PCR product or a highly
concentrated template, such as a cDNA clone.

— If you have a limited amount of cDNA template and/or if the target is a low-copy
number transcript, or known to occur within a given range, a narrow range of
standard quantities may be necessary.

» The serial factor is used to calculate the quantities in all points of the standard curve.
If your starting quantity is the highest quantity, select a dilution factor such as 1:2,
1:3, and so on. If your starting quantity is the lowest quantity, select a concentration
factor such as 2X, 3X, and so on.

For More For more information on:

Information * Completing the Standards screen — Open the 7500 Software Help by clicking ) or
pressing F1.

* Amplification efficiency — Refer to the Amplification Efficiency of TagMan® Gene
Expression Assays Application Note.

Notes
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Set Up the Samples

In the Samples screen, enter the number of samples, replicates, and negative controls to
include in the reaction plate, enter the sample names, then select the sample/target
reactions to set up.

About the In the standard curve example experiment:

Exa_lmple » Two samples are used: genomic DNA from two populations. The samples contain
Experiment unknown quantities of the target (RNase P).

» Three replicates are used. The replicates are identical reactions, containing identical
reaction components and volumes.

» Three negative controls are used. The negative control reactions contain water
instead of sample and should not amplify.

Complete the 1. Click the How many samples do you want to test in the reaction plate? field,
Samples Screen then enter 2.

Note: The number of rows in the samples table is updated with the number you entered.

2. Click the How many replicates do you need? field, then enter 3.

3. Click the How many negative controls do you need for each target assay? field,
then enter 3.

4. Setup Sample 1:
a. Click the Enter Sample Name field, then enter pop1 (for population 1).
b. In the Color field, leave the default.

5. Set up Sample 2:
a. Click the Enter Sample Name field, then enter pop2 (for population 2).
b. In the Color field, leave the default.

6. Seclect No Biological Replicates (default).
7. Select All Sample/Target Reactions to test all targets in all samples (default).

8. In the Well Count pane, verify that there are:
e 6 Unknown wells [T
* 15 Standard wells [5]
* 3 Negative control wells []
e 72 Empty wells
9. In the View Plate Layout tab:

a. In the Arrange Plate by drop-down list, select Rows (default).
Notes
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b. In the Place Negative Controls in drop-down list, select Upper Left (default).
10. Click Next.

2C. Set Up: Samples Samples Help g.

G Instructions: ENerthe number of samples to testin the reaction plate, enter the number of sampleltarget reaction replicates, enter the number of negative controls, enter sample
" names, associate the samples with biological replicate groups, then select the sampleftarget reactions to set up

Set Up Samples = Required fa : View Plate Layout
. . T \
1 How many samples do you want to test in the reaction plate ? Arrange Plate by. |Rows B Place Megative Contrals in: (Upper Left  +
{

+ How many replicates do you need? 3
3 + How many neqative controls do you need for each target assay? ‘3 |

9a
9b

how in Wells ¥ View Legend

For each sample in the reaction plate, enter a sample name and select a sample t2lal a8 a7 [ & [a[10]i1[12]
color,

- G @ P01 Bopt | popl | pop2  ponZ | mop2 R o o
* Enter Sample Name Color A D D D mR. mﬁ mR. mR. mn mn_ @, B‘ ?‘

ar

IN

lng v
5 |”;p 2l : s B @Y EME @F @3¢ 8¢ @ gr gc gr g@v

||p092 R cra £ra era Acra Aacea|aceal 4 4 4 Ac |emc  anc  &ac

hd | ¥

Set Up Biological Replicate Groups D

6 77{ + No Biological Replicates ][ Specify Biological Replicate Groups ]

Which sample/target reactions do you want to set up? .

<[ < All Sample/Target Reactions ][ Specify Sample/Target Reactions J 1

|

| @6 - unknown [E15- standard [ 3 - Negative Control 72 - Empty ||
v

Design  When you design your own standard curve experiment:

Guidelines * Identify each sample with a unique name and color. You can enter up to 100

characters in the Sample Name field.

» Enter the number of replicates (identical reactions) to set up. Applied Biosystems
recommends three replicates for each sample reaction.

» Enter the number of negative control reactions to set up. Applied Biosystems
recommends three negative control reactions for each target assay.

* You can set up biological replicate groups (see “Set Up Biological Replicate
Groups”). Biological replicates allow you to assess the representative nature of your
results as they relate to the population being studied. Inclusion of biological
replicates can give insight into any natural variation that is present within the
population.

* Select which targets to test in the samples:

— Select All Sample/Target Reactions to test all targets in all samples.

— Select Specify Sample/Target Reactions to specify the targets to test in each sample.

IMPORTANT! When you use the Design Wizard to set up a standard curve
experiment, you can set up only singleplex reactions (amplification and detection of
one target per well). If you want to set up a standard curve experiment with multiplex
reactions (amplification and detection of two or more targets per well), design your
experiment using Advanced Setup (see page 98) instead of the Design Wizard.

Notes
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Set Up Biological Replicate Groups
1. Select Specify Biological Replicate Groups.

2. Enter the number of biological replicate groups that you want to test in the reaction
plate.

3. For each biological replicate group, click the cell in the Biological Group Name
column, then enter a name for the biological group. For example, BrainGP.

4. Assign the biological replicate group(s) to the reaction plate:

a. Select wells in the reaction plate that contain samples associated with the
biological replicate group.

b. In the Assign column, select the check box of the appropriate biological
replicate group.

Set Up Biological Replicate Groups

[ INo Biological Replicates ” + Specify Biological Replicate Groups %

* How many Biological Replicate Groups do you want to testin the reaction plate?
Select well(s) in the plate layout, then assign a hiological replicate group from the list.

Assign Biological Group Mame Color Comments
4b M BrainGP v |
O LiverGP v |

For More For more information on:

Information + Completing the Samples screen — Open the 7500 Software Help by clicking @) or
pressing F1.

» Using Advanced Setup — See “Advanced Setup Workflow” on page 98.

Set Up the Run Method

In the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method or replace it with one
from the Run Method library.

About the In the standard curve example experiment, the default run method is used with one

Example change: The reaction volume per well is changed from 50 pL to 25 uL.
Experiment

Notes
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Review the Run 1. Select either the Graphical View tab (default) or Tabular View tab.

Method Screen ,
Click the Reaction Volume Per Well field, then enter 25 uL.

3. Make sure the thermal profile displays the holding and cycling stages shown below.
If necessary, add a step, or click a temperature or time setting, then change it.

4. Click Next.

2D. Set Up: Run Method Run Method Help @
n Instructions: Review the reaction volume and the thermal profile for the default run method. If needed, edit the default run method or select a run method from the library.
1 rGraphical ViewI Tabular View ]
5 Reaction Volume Perwell | B L[] ExpertMode |
Add Stage ¥ | Add Step ¥ | Delete Selected ‘ || Collect Data ¥ H Open Run Method | Save Run Method .. | Revertto Defaults | |
[T Holding Stage Holding Stage Cycling Stage
Mumber of Cycles 40 ¢
[] Enable AutaDelta
Starting Cycle: [
100 —| 95.0°C 95.0°C
10:00 100% 00:15
3 & 00% e 50.0°C
. 50.0°C 01:00
W
100%
= Stap 1 Step 1 Step 1 Step 2
< >
Legend
Data Collection On Data Collection Off A AutoDelta On A& AutoDelta Off
Design  When you design your own standard curve experiment:

Guidelines » Enter a reaction volume/well. Applied Biosystems recommends a reaction volume
of 25 uL for standard curve experiments. The 7500 system supports reaction
volumes from 20 to 100 puL. The 7500 Fast system supports reaction volumes from
10 to 30 uL.

* Review the thermal profile:
— Make sure the thermal profile is appropriate for your reagents.
— Ifyou are performing 1-step RT-PCR, include a reverse transcription step.
If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the 7500 software.
For More For more information on:
Information * The Run Method library or on completing the Run Method screen — Open the 7500
Software Help by clicking ) or pressing F1.
» Using Advanced Setup — See “Advanced Setup Workflow” on page 98.
Notes
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve 31

Experiments



m Chapter 2 Design the Standard Curve Experiment
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Review the Reaction Setup

About the
Example
Experiment

In the Reaction Setup screen, select the assay type (if using TagMan reagents), then review
the calculated volumes for preparing the PCR reactions, standard dilution series, and
sample dilutions. If needed, you can edit the reaction volume, excess reaction volume,
component concentrations, standard concentration, and/or diluted sample concentration.

IMPORTANT! Perform the steps above for each target assay in the reaction plate.

In the standard curve example experiment:

Applied Biosystems RNase P assay is used.

* The reaction volume per well is 25 uL.

The excess reaction volume is 10%.
The reaction components are:

TagMan® Universal PCR Master Mix (2X) or
TagMan® 2X Universal PCR Master Mix, No AmpErase® UNG

RNase P Assay Mix (20X)

— Sample or standard

— Water

The standard concentration (stock) is 20,000 copies/uL.

The diluted sample concentration is 6.6 ng/uL.
The sample concentration (stock) is 100 ng/uL.

Complete the Complete the Reaction Mix Calculations Tab (see page 33)
Reaction Setup

Notes

32

Screen

1. Select the Reaction Mix Calculations tab (default).

o o M 0 D

In the Select Target pane, select RNase P TAMRA (default).

In the Assay Type drop-down list, select Inventoried/Made to Order (default).
Make sure the Reaction Volume Per Well field displays 25 pL.

Make sure the Excess Reaction Volume field displays 10% (default).

In the Reactions for RNase P TAMRA pane:
a. Make sure the Master Mix Concentration field displays 2.0X (default).
b. Make sure the Assay Mix Concentration field displays 20.0X (default).

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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c. Review the components and calculated volumes for the PCR reactions:

Component Volume for 1 Reaction (uL)
Master Mix (2.0X) 12.50
| Assay Mix (20.0X) 1.25
| Sample (10X) or Standard 2.50%
H,O 8.75
Total Volume 25.00

I The sample or standard volume is limited to 10% of the total reaction volume.

3 4 5

2E. Set Up: Reaction Setup Reaction Setup Help @

For each target assay in the reaction plate, selef:tthe assay type (if using TagMan reaclents], then review the calculated volumes| for preparing the standard dilution series,
n Instructions: samples, and PCR reactions If needed, edit thi: reaction volume, excess reaction volume, component concentrations, and/or s{ack concentrations. Click "Print Reaction
Setup” to printinstructions on how to prepare thiz PCR reactions

1 — [Reaction Mix Calculations T Sarmple Dilution Calculations W
Select Target: ———
2 == Assay Type |Inventoried/Made to Order |« Reaction Volume Per Well 25 | UL Excess Reaction Yolume: 10 | % Print Reaction Setup
6a Reactions for RNase P TAMRA i)
6b Master Mix Concentration X AssayMixConcentration: | 20.0 | X
I Compaonent Volume (uL) for 1 Reaction
12.50)
1.25
6c 250
Hz0 8.75
Total Volume 25.00)
Standard Concentration in Stock | 100.0 ||ng v‘ perpL
Dilution Point Source Source Volume (L) Diluent Valume (L) Total Valume (uL) Standard Concentrati
1 (10,000) | ‘ ||
2 (5,000) [
The standard concentration in
3(2,500) stock entered is too low to
= prepare the standard dilution
2250 series. Enter a number greater ~
7. In the Standard Dilution Series for RNase P TAMRA pane (see page 34):
a. Click the Standard Concentration in Stock field, then enter 20000.
b. Click the units field, then enter copies per uL.
Notes
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c. Review the calculated volumes for preparing the standard dilution series:

Dilution Source Source Volume Diluent Volume Total Volume Standard Concentration
Point (uL) (bL) (bL) (ng/pL)
1 (10000) Stock 3.63 14.52 18.15 4000.0
2 (5000) Dilution 1 9.08 9.08 18.15 2000.0
3 (2500) Dilution 2 9.08 9.08 18.15 1000.0
4 (1250) Dilution 3 9.08 9.08 18.15 500.0
5 (625) Dilution 4 9.08 9.08 18.15 250.0
| | i S|
,
a |
Standard Concentration in Stock: | 200000 | kopies | peruL
7b | Dilution Point Source Source ‘anume (uL) Diluent Volume (pL) Total Volume (L) Standard Concentration {ng/uL)
1 (10,000) Stock 3.63 14.52] 18.15 4000.0
2 (5,000) Dilution 1 9.08 9.08 18.15 2000.0
7C 3(2,500) Dilution 2 9.08 9.08 18.15 1000.0
4(1,250) Dilution 3 9.08 9.08 18.15 500.0]
5 (625) Dilution 4 9.08 9.08 18.15 250.0]
Complete the Sample Dilution Calculations Tab
1. Select the Sample Dilution Calculations tab.
2. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then
enter 6.6.
3. In the unit drop-down list, select ng/uL (default).
. Review the calculated volumes for the sample dilutions:
4. R the calculated vol for th ple dilut
Sample Stock Concentration Sample Volume Diluent Volume Total Volume of Diluted Sample
Name (ng/pL) (bL) (uL) (bL)
pop1 100.0 1.00 14.15 15.15
pop2 100.0 1.00 14.15 15.15
2E. Set Up: Reaction Setup Reaction Setup Help @
For each target assay in the reaction plate, select the assay type (if using TagMan reagents]), then review the calculated volumes for preparing the standard dilution series,
“ Instructions: samples, and PCR reactions If needed, edit the reaction volume, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print Reaction
1 Setup” to printinstructions on how to L]IEL]E\E“W? PCR reactions
) [ Reaction Mix Calculations T Sample Dilution Calculations W
3 H Diluted Sample Concentration (10X for Reaction Mix); ‘ 6.8 | |ng/L T | Brint Reaction Setup
“ Sample Name Stock Concentration (ng/uL) Sample Volume (L) DiluentVolume (L) Total Wolume of Diluted Sample (uL)
4 ‘ popt [100.0 | 1.00, 1415 1515
‘ pop2 [100.0 | 1.00, 1415 1515
Notes
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Print Reaction Setup Instructions

Print detailed reaction setup instructions, then save the instructions for Chapter 3,
“Prepare the Reactions.”

1. Click Print Reaction Setup.

Reaction Setup Help @

te, selectthe assay type (if using TagMan reagents), then review the calculated volumes for preparing the standard dilution series,
aditthe reaction volums, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print Reaction
pare the PCR reactions

lution Calculations
6.6 | nguL v | Print Reaction Setup | 1
g Sample Volume (L) Diluent Volume (uL) Total Volume of Diluted Sample (UL)

| 1.00| 1415| 1515

2. In the dialog box, select:

* Detailed Reaction Setup Instructions
* Include Plate Layout
* Use sample color

3. Click Print to print the reaction setup instructions.

Print Reaction Setup Instructions &
u Selectthe type of instructions to print.

 summary Reaction Setup Instructions
[T @ Detailed Reaction Setup Instructions
2 inciude Biate Cayout

Plate Layout Print Options

| ® Use sample color

) Use task color

1
| Preview | Prirt | Cancel

4. Click Next.

Notes
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Notes
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Review the Reaction Setup

Design  When you design your own standard curve experiment:

Guidelines .

If you are using TagMan reagents, select the type of assay you are using:

— Select Inventoried/Made to Order if you are using Applied Biosystems
TagMan® Gene Expression Assays (Inventoried or Made to Order) or Applied
Biosystems Custom TagMan® Gene Expression Assays.

— Select Custom if you are designing your own assays with Primer Express®

software.

Enter a reaction volume/well. Applied Biosystems recommends a reaction volume
of 25 uL for standard curve experiments. The 7500 system supports reaction
volumes from 20 to 100 uL. The 7500 Fast system supports reaction volumes from
10 to 30 puL.

Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

Review the reaction mix concentrations for each target. If needed:

— For TagMan reagents, edit the master mix and assay mix concentrations.

— For SYBR Green reagents, edit the master mix, forward primer, and reverse
primer concentrations.

— For 1-step RT-PCR, edit the reverse transcriptase concentration.

Review the reaction mix components for each target:

— If you are running Fast PCR reactions, make sure you use Fast master mix in the
PCR reactions.

— If you are running standard PCR reactions, make sure you use standard master
mix in the PCR reactions.

— For 1-step RT-PCR, make sure you include reverse transcriptase in the PCR
reactions and use a specific buffer.

Review the standard dilution series calculations for each target. If needed, edit the
Standard Concentration in Stock (including units).

Note: For the Standard Concentration in Stock units field, you can select ng or ug
in the drop-down list or you can enter another unit in the field (for example, copies,
IU, [International Units], nmol, pg, and so on). The table is updated according to
your entry.

Review the sample dilution calculations for each sample. If needed, edit the diluted
sample concentration (including units) and stock concentration.

For More For more information on:

Information .

Completing the Reaction Setup screen — Open the 7500 Software Help by clicking
@) or pressing F1.

Applied Biosystems assays — Refer to the:

— TagMan® Gene Expression Assays Protocol

— Custom TagMan® Gene Expression Assays Protocol

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Order Materials for the Experiment

Order Materials for the Experiment

In the Materials List screen, review the list of materials recommended to prepare the
PCR reaction plate. (Optional) Print the materials list, create a shopping list, then order
the recommended materials from the Applied Biosystems Store.

Note: To open the Applied Biosystems Store, you need to have an Internet connection.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The 7500 software recommends the materials to order based on your experiment
design. It is assumed that you will design your experiment, order your materials, then
prepare (Chapter 3) and run (Chapter 4) the reaction plate when your materials arrive.

About the In the standard curve example experiment, the recommended materials are:
Exa_lmple + MicroAmp® Optical 96-Well Reaction Plate
Experiment + MicroAmp" Optical Adhesive Film
+ MicroAmp® Splash Free Support Base

+ TagMan® Universal PCR Master Mix (2X) or TagMan® Universal PCR Master
Mix, No Amperase® UNG

* Applied Biosystems RNase P assay

Complete the 1. For the example experiment, leave the Find Assay pane empty.

Materials List You can order the human RNase P FAM"™ dye-labeled probe from Applied
Screen Biosystems as the TagMan® RNase P Detection Reagents (FAM dye) (PN 4316831).

Note: When you design your own standard curve experiment, see “Design
Guidelines” on page 39 for information on how to complete the Find Assay pane.

2. In the Display drop-down list, select All Items (default), then review the
recommended materials. If needed, use the scroll bar at right to see all items.

Note: For more information on a specific item, click the part number link. You are
connected to the product information screen in the Applied Biosystems Store. To
open the Applied Biosystems Store, you must have an Internet connection.

3. (Optional) Click Print Materials List to print the materials list.

Notes
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4. (Optional) Create a shopping list:

a. Select the check box next to each of the following items:
+ MicroAmp® Optical 96-Well Reaction Plate
+ MicroAmp"" Optical Adhesive Film
+ MicroAmp® Splash Free Support Base
+ TagMan® Universal PCR Master Mix (2X) or TagMan® Universal PCR
Master Mix, No Amperase® UNG

b. Click Add Selected Items to Shopping List.

5. (Optional) Create a shopping basket in the Applied Biosystems Store. Product
availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries.
Contact your local Applied Biosystems representative for help.

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Log In and Submit.

Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.

Order Materials - Log In g|
Log into the Applied Biosystems Store to place the selected items in your shopping basket. If you do not
have a user name and password, click "Register Now” o create a new account

p \ oR p -

Store Log In Register
To log into the Applied Biosystems Store, enter your user Ifyou do not have
name and password then click"Log In and Submit'. an Applied
— Biosystems
User Name: account, click the
link below to
create a new
5b Password account
| Log In and Submit Cancel
Register Now
1 Remember my user name and password for future arders

c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.

6. Go to “Finish the Design Wizard” on page 40.

Notes
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Design  When you design your own standard curve experiment:

Guidelines Select all the materials that you require for your experiment, then add them to your

shopping list.
» To access and use the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.

— Use the following Applied Biosystems-recommended browsers.

Microsoft®

Desktop Google Internet Macintosh® Mozilla®
Operating System Chrome™ Explorer Safari Firefox®
Windows ®XP/ Most recent v8 or later Not applicable Most recent
Windows® 7 version version

Macintosh® OS 9+ | Not supported | Not supported Most recent Most recent
or later version version

IMPORTANT! Make sure that cookies and Java Script are turned on.

* To find your assay in the Applied Biosystems Store, complete the Find Assay pane:
a. Click the Enter Gene Name ficld, enter the gene name, then click Find Assay.
b. In the Find Assay Results dialog box, select your assay.
c. Click Apply Assay Selection.

r_-._ Find Assay Results @

7 Assays Found. Click the Assay ID to view the assay in the Applied Biosystems Store. Select an assay to detect and guantify the target sequence. mase p
Availability Assay D Gene Symhbol | Gene Name RefSeq
MenEnoIC e Dm01837058 gl Rpp30 RMNaseP protein p30 MNM_080010.2
Made to Order Dm01837057 gl Rpp30 RNaseP protein p30 NM_D80010.2
Made to Order Dm01837056 g1 Rpp30 RNaseP protein p30 NM_D80010.2
Made to Order Dm01837055 g1 Rpp30 RNaseP protein p30 NM_DB80010.2
\ade to Order Rn01479857 mi LOCEB5332 similar to Ribonuclease P protein subunit p30 (RNaseP protein p30) (RMas... XM_001063377.1
rcG48258 Gene rCG48258 Celera Annotation
\ads o Order Rn01479850 mi LOCE85332 similarto Ribonuclease P protel.n subunit p30 (RNaseP protein p30) (RNas... XM_001063377.1
rGG48258 Gene rCG48258 Celera Annotation
R T RN01479855 mi LOCEB5332 similar to Ribonuclease P protein subunit p30 (RNaseP protein p30) (RMas... XM_001063377.1
rCG48258 Gene rCG48258 Celera Annotation
| /| | 10f1 | mests || Last | | || cancel

For More For more information on completing the Materials List screen, open the 7500 Software
Information  Help by clicking g) or pressing F1.

Notes
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Finish the Design Wizard

Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

About the The 7500 software automatically selects locations for the wells in the reaction plate. In
Example the standard curve example experiment:

Experiment * The wells are arranged as shown below.

1 2 3 4 5 B 7 8 9 10 ah 12
popT popT popT PoF PoF PoF
Riase Riase Riase
A D RNase D RNase D RNase VLI RNase VLI RNase VLI RNase VLI RNase VLI RNase VLI RNase Eﬁ Eﬁ Eﬁ
2.77E3 2.84E3 2.81E3 5.31E3 5.5E3 5.54E3
[ Rtese . [ Rhiese | [ Riiese | [ Riase . [ Rhiase | [ Riese [ Rhase . [ Rhase . [ Riese ., [ Rhase . [ Rhase . [ Riiase
E 5E3 5E3 5E3 2.5E3 2.5E3 2.5E3 1.25E3 1.25E3 1.25E3 625 625 625
o3
(v}
E
F
G
H
wells: [ 6 Unknown [ 15 Standard [1] 3 Negative Control 72 Empty

» The experiment is saved as is and closed.

Note: For the example experiment, do not perform the run at this time.

Notes
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Finish the Design Wizard

Finishthe 1. At the bottom of the 7500 software screen, click Finish Designing Experiment.

Design Wizard ) ) ) _
2. Inthe Review Plate Layout for Experiment window, review the plate layout. Make
sure there are:
e 6 Unknown wells
e 15 Standard wells [
* 3 Negative control wells [
* 72 Empty wells
Note: If the plate layout is incorrect, click Return to the Wizard and check your
entered values.
3. Click Save Experiment.
‘_ Review Plate Layout for, Experiment “Standard Curve Example™
a Review the plate layout, then selectwhat you want to do naxt.
3 I Save Experiment ‘ Start Run for This Experiment ‘ Edit Plate Layout ‘ CLT;:‘Z ?h"em[;‘:;i::ﬁ:::“ ‘ Return to the Wizard ‘
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experimant, start the run. Make sure the the plate layout. experiment, then create experiment using the Dasign
reaction plate is loaded into another experiment using the Wizard
the instrument. Design Wizard
| [0 | showinwells ¥ | P view Legend | B
1 [ 2 ] s ] 4« [ s | & [ ¢ [ s ] 9 [ 1w | m [ 1z |
A |CI e CI e [ | g s [ oase.. [ .. g ... Fese. e E1 e D e [
; Ij RNase... Ij RNase... Ij RNase D RMase.. Ij RNase... Ij RNase... Ij RNase D RMase.. Ij RNase... Ij RNase... Ij RNase D RMase..
o]
D
2 -
E
F
]
H
4. In the Save Experiment dialog box, enter Standard Curve Example Setup.eds in
the File name drop-down list, then click Save. The example experiment is saved and
closed, and you are returned to the Home screen.
IMPORTANT! Do not save the experiment using the default file name. Doing so will
overwrite the example experiment already present in the experiments folder.
Note: By default, the example experiment is saved to the <drive>:\
Applied Biosystems\<software name>\experiments folder.
Notes
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Finish the Design Wizard

Design  When you design your own standard curve experiment:

Guidelines * In the Review Plate Layout for Experiment window, select the appropriate exit option:

Click To...

Save Experiment Save and close the experiment without making any
further changes or starting the run.

Start Run for This Experiment Save the experiment and start the run. Make sure
the reaction plate is loaded in the instrument.

Edit Plate Layout Use Advanced Setup to edit the plate layout.
Create Another Experiment Save and close the current experiment, then create
Using the Design Wizard another experiment using the Design Wizard.
Return to the Wizard Return to the experiment to make changes using

the Design Wizard.

* By default, experiments are saved to:
<drive>:\Applied Biosystems\<software name>\experiments
To change the:

— Save location for a specific experiment — Navigate to the desired location using
the Save Experiment dialog box.

— Default save location — Select Tools » Preferences, then select the General tab.
In the Data Folder field, browse to then select the desired location.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on
Information page 98.

Notes
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Prepare the Reactions

This chapter covers:

B Chapter OVerVIBW . . . ottt ettt e e e e e et e ettt 44
B Prepare the Sample Dilutions . . . ........ .. .. .. 45
B Prepare the Standard Dilution Series . ............ ... ... 47
B Prepare the Reaction MixX .. ... ... i 49
B Prepare the ReactionPlate . ....... ... .. .. . . . 51

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve 43
Experiments



m Chapter 3 Prepare the Reactions
Chapter Overview

Chapter Overview

This chapter explains how to prepare the PCR reactions for the standard curve example

experiment and provides guidelines for how to prepare the PCR reactions for your own
standard curve experiment.

Example Start Experiment
Experiment \
Workflow Design the Experiment (Chapter 2)
v

Prepare the Reactions (Chapter 3)
1. Prepare the sample dilutions.
2. Prepare the standard dilution series.
3. Prepare the reaction mix for each target assay.
4. Prepare the reaction plate.

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

v

End Experiment

Notes
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Prepare the Sample Dilutions

Prepare the Sample Dilutions

Perform sample dilutions before adding the samples to the final reaction mix. Dilute the
samples using the volumes that were calculated by the 7500 software (“Complete the
Sample Dilution Calculations Tab” on page 34).

About the For the standard curve example experiment:

Exa_lmple » Sample dilutions are necessary because the sample volume is limited to 10% of the
Experiment total reaction volume in the 7500 software. Because the total reaction volume is
25 uL/reaction, the sample volume is 2.5 pL/reaction.

» The stock concentration is 100 ng/uL. After diluting the sample according to the
Sample Dilutions Calculations table, the sample has a concentration of 6.6 ng/uL.
Adding 2.5 pL at this concentration to the final reaction mix volume of 25 uL yields
a 1X concentration in the final reaction.

e The volumes calculated in the software are:

Sample Stock Concentration Sample Volume Diluent Volume Total Volume of Diluted Sample
Name (ng/pL) (uL) (uL) (uL)
pop1 100.0 1.0 1415 15.15
pop2 100.0 1.0 14.15 15.15

Required + Water (to dilute the sample)
Materials + Microcentrifuge tubes
* Pipettors

* Pipette tips
» Sample stock
» Vortexer

* Centrifuge

Prepare the 1. Label a separate microcentrifuge tube for each diluted sample:
Sample Dilutions « Population 1

* Population 2

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample Name Diluent Volume (uL)
1 Population 1 14.15
2 Population 2 14.15
Notes
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Chapter 3 Prepare the Reactions
Prepare the Sample Dilutions

3. Add the required volume of sample stock to each tube:

Tube Sample Name Sample Volume (pL)
1 Population 1 1.0
2 Population 2 1.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Preparation When you prepare your own standard curve experiment:

Guidelines » Sample dilutions may be necessary because the sample volume is limited to 10% of
the total reaction volume in the 7500 software. You must perform the sample
dilutions before adding the samples to the final reaction mix.

+ For optimal performance of TagMan® Gene Expression Assays or Custom
TagMan® Gene Expression Assays, use 10 to 100 ng of cDNA template per
20-uL reaction. For Fast reagents, Applied Biosystems recommends 10 ng.

* Use TE buffer or water to dilute the sample.

For More For more information on Applied Biosystems assays, refer to the:
Information » TagMan® Gene Expression Assays Protocol

» Custom TagMan® Gene Expression Assays Protocol

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
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Prepare the Standard Dilution Series

Prepare the standard dilution series using the volumes that were calculated by the 7500
software (“Complete the Reaction Mix Calculations Tab (see page 33)” on page 32).

About the For the standard curve example experiment:
Example * The standard concentration (stock) is 20,000 copies/uL.

Experiment * The volumes calculated in the software are:
DiIuFion Source Source Volume Diluent Volume Total Volume Standard Concentration
Point (uL) (ML) (uL) (ng/pL)
1 (10,000) Stock 3.63 14.52 18.15 4000.0
2 (5,000) Dilution 1 9.08 9.08 18.15 2000.0
3 (2,500) Dilution 2 9.08 9.08 18.15 1000.0
4 (1,250) | Dilution 3 9.08 | 9.08 18.15 500.0
5 (625) Dilution 4 9.08 9.08 18.15 250.0

Required « Water (to dilute the standards)
Materials  Microcentrifuge tubes

» Pipettors

* Pipette tips

+ Standard stock

¢ Vortexer

* Centrifuge

Prepare the 1. Label a separate microcentrifuge tube for each standard:
Standard Dilution ¢ RNase P Std. 1
Series for the
* RNase P Std. 2
RNase P Assay ase
* RNase P Std. 3

¢ RNase P Std. 4
e RNase P Std. 5

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve 47
Experiments



m Chapter 3 Prepare the Reactions
Prepare the Standard Dilution Series

2. Add the required volume of water (diluent) to each empty tube:

Tube Standard Name Volume of Diluent to Add (uL)
1 RNase P Std. 1 9.08
2 | RNase P Std. 2 9.08
3 RNase P Std. 3 9.08
4 RNase P Std. 4 9.08
5 RNase P Std. 5 9.08

3. Prepare dilution 1 in the RNase P Std. 1 tube:
a. Vortex the stock for 3 to 5 seconds, then centrifuge the tube briefly.
b. Using a new pipette tip, add 9.08 uL of stock to the RNase P Std. 1 tube.
c. Vortex Std. 1 for 3 to 5 seconds, then centrifuge the tube briefly.

4. Prepare dilution 2 in the RNase P Std. 2 tube:
a. Using a new pipette tip, add 9.08 pL of dilution 1 to the RNase P Std. 2 tube.
b. Vortex Std. 2 for 3 to 5 seconds, then centrifuge the tube briefly.

5. Prepare dilution 3 in the RNase P Std. 3 tube:
a. Using a new pipette tip, add 9.08 pL of dilution 2 to the RNase P Std. 3 tube.
b. Vortex Std. 3 for 3 to 5 seconds, then centrifuge the tube briefly.

6. Prepare dilution 4 in the RNase P Std. 4 tube:
a. Using a new pipette tip, add 9.08 pL of dilution 3 to the RNase P Std. 4 tube.
b. Vortex Std. 4 for 3 to 5 seconds, then centrifuge the tube briefly.

7. Prepare dilution 5 in the RNase P Std. 5 tube:
a. Using a new pipette tip, add 9.08 pL of dilution 4 to the RNase P Std. 5 tube.
b. Vortex Std. 5 for 3 to 5 seconds, then centrifuge the tube briefly.

8. Place the standards on ice until you prepare the reaction plate.

Preparation When you prepare your own standard curve experiment:

Guidelines » Standards are critical for accurate analysis of run data.

* Any mistakes or inaccuracies in making the dilutions directly affect the quality of
results.

» The quality of pipettors and tips and the care used in measuring and mixing
dilutions affect accuracy.

¢ Use TE buffer or water to dilute the standards.

Notes
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Prepare the Reaction Mix

Prepare the Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the
7500 software (“Complete the Reaction Mix Calculations Tab (see page 33)” on page 32).

Note: The software calculates the volumes for all components for the PCR reactions.
However, when you prepare the reaction mix in this section, include only the master mix,
assay mix, and water. Add the sample or standard when you prepare the reaction plate
(see “Prepare the Reaction Plate” on page 51).

About the For the standard curve example experiment:

Exgmple * The reaction mix components are:
Experiment — TagMan® Universal PCR Master Mix (2X) or TagMan® 2X Universal PCR
Master Mix, No AmpErase® UNG
— RNase P Assay Mix (20X)
— Water

* The volumes calculated in the software are:

Component Volume for 1 Reaction (uL)
Master Mix (2.0X) 12.50
Assay Mix (20.0X) 1.25
H,O 8.75
Total Volume | 22.50

Note: The sample or standard is not added at this time.

Required * Microcentrifuge tubes

Materials « Pipettors
* Pipette tips
* Reaction mix components (listed above)
» Centrifuge

Prepare the CHEMICAL HAZARD. TagMan® Universal PCR Master Mix (2X)
Reaction Mix may cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled.
Read the MSDS, and follow the handling instructions. Wear appropriate protective eyewear,
clothing, and gloves.

Notes
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Prepare the Reaction Mix

ACAUTION CHEMICAL HAZARD. TagMan® 2X Universal PCR Master Mix,

No AmpErase® UNG may cause eye and skin irritation. Exposure may cause discomfort if
swallowed or inhaled. Read the MSDS, and follow the handling instructions. Wear
appropriate protective eyewear, clothing, and gloves.

1. Label an appropriately sized tube for the reaction mix: RNase P Reaction Mix.

2. For the RNase P assay, add the required volumes of each component to the tube:

Component Volume for Volume for 24 Reactions Plus
p 1 Reaction (pL) 10% Excess (uL)
TagMan® Universal PCR Master Mix (2X) or 12.50 330.0
TagMan® 2X Universal PCR Master Mix, No AmpErase® UNG
RNase P Assay Mix (20X) 1.25 33.0
Water 8.75 231.0
Total Reaction Mix Volume 22.50 594.0

3. Mix the reaction mix by gently pipetting up and down, then cap the tube.

4. Centrifuge the tube briefly to remove air bubbles.

5. Place the reaction mix on ice until you prepare the reaction plate.

Preparation When you prepare your own standard curve experiment:

Guidelines * If your experiment includes more than one target assay, prepare the reaction mix for

each target assay separately.

* Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers. Applied Biosystems recommends an excess

volume of at least 10%.

¢ Include all required components.

* Prepare the reagents according to the manufacturer’s instructions.

* Keep the assay mix protected from light, in the freezer, until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes.

¢ Prior to use:

— Mix the master mix thoroughly by swirling the bottle.

— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

For More For more information on preparing the reaction mix, refer to the protocol appropriate for
Information the reagents you are using in the PCR reactions:

s TagMan® Gene Expression Assays Protocol

s Custom TagMan® Gene Expression Assays Protocol
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Prepare the Reaction Plate

Prepare the Reaction Plate

Prepare the reactions for each replicate group, then transfer them to the reaction plate
using the plate layout displayed in the 7500 software.

About the For the standard curve example experiment:
Example + A MicroAmp® Optical 96-Well Reaction Plate is used.

Experiment : :
P The reaction volume is 25 pL/well.
* The reaction plate contains:
— 6 Unknown wells [I]
— 15 Standard wells [£]
— 3 Negative control wells [
— 72 Empty wells
* The plate layout that the 7500 software automatically generates is used:
%/ Review Plate Layout for Experiment “Standard Curve Example®
G Review the plate layout, then select what you wantto do next.
‘ Save Experiment Start Run for This Experiment ‘ Edit Plate Layout ‘ c[;‘i’:‘z’t‘h":‘[;‘:;i::w;':f:‘ ‘ Return to the Wizard ‘
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this
experiment. startthe run. Make sure the the plate layout. experiment, then create experimentusing the Design
reaction plate is loaded into another experiment using the Wizard.
the instrument. Design Wizard
| @Shuwinwm\sv | Wiew Legend | | @ | N |
[z [ 3 [ 4 ] & | & [ 7 [ & [ & [ 10 [ 11 ] 12 |
A |1 GRe== | Tk | O] Gle==- m;nwn;se m:ohl:‘sa... m;olul:se... m;nwfse m:or:sa... m;onfse s [l s [l s [
; E RNase B RMase... E RNase... E RNase B RMase... E RNase... E RNase B RMase... E RNase... E RNase B RMase... E RNase...
[
D
E
F
<}
H
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Prepare the Reaction Plate

Required * Microcentrifuge tubes
Materials « Pipettors
* Pipette tips
* RNase P reaction mix (from page 49)
* Water
+ Standards (from page 47)
* Samples (from page 45)
+ MicroAmp® Optical 96-Well Reaction Plate
* MicroAmp"" Optical Adhesive Film
* Centrifuge

Prepare the 1. Prepare the negative control reactions for the target:

Reaction Plate a. To an appropriately sized tube, add the volumes of reaction mix and water

listed below.

Tube Reaction Mix Reaction Mix Volume (uL) | Water Volume (uL)

1 RNase P reaction mix 74.25 8.25

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 25 pL of the negative control reaction to the appropriate wells in the
reaction plate.

2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard
listed below.

Tube | Standard Reaction Reaction Mix F\‘/iﬁ\iq?(mx Standard Standa(TL\)lolume
1 RNase P Std 1 RNase P reaction mix 74.25 RNase P Std 1 8.25
2 RNase P Std 2 RNase P reaction mix 74.25 RNase P Std 2 8.25
3 RNase P Std 3 RNase P reaction mix 74.25 RNase P Std 3 8.25
4 RNase P Std 4 RNase P reaction mix 74.25 RNase P Std 4 8.25
5 RNase P Std 5 RNase P reaction mix 74.25 RNase P Std 5 8.25

b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 25 pL of the standard reaction to the appropriate wells in the reaction plate.

Notes
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Prepare the Reaction Plate

3. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample listed

below.
. . . Reaction Mix Sample Volume
Tube Unknown Reaction Reaction Mix Volume (uL) Sample (uL)
1 RNase P pop1 RNase P reaction mix 74.25 pop1 8.25
2 RNase P pop2 RNase P reaction mix 74.25 pop2 8.25

b. Mix the reactions by gently pipetting up and down, then cap the tubes.

c. Centrifuge the tubes briefly to remove air bubbles.

d. Add 25 uL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.

4. Seal the reaction plate with optical adhesive film.
Centrifuge the reaction plate briefly to remove air bubbles.

Verify that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can

contaminate the sample block and cause an abnormally high background signal.

Correct Incorrect

- Ly

Liquid is at the o

Not centrifuged with enough force, or
bottom of the well.

¢ Not centrifuged for enough time

7. Place the reaction plate on ice in the dark until you are ready to perform the run.

Preparation

When you prepare your own standard curve experiment:
Guidelines

» Make sure you use the appropriate consumables.

* Make sure the arrangement of the PCR reactions matches the plate layout displayed
in the 7500 software. You can either:

— Accept the plate layout automatically generated by the software.
or

— Use Advanced Setup to change the plate layout in the software.

Notes
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* If you use optical adhesive film, seal each reaction plate as follows:

a.
b.

C.

Place the reaction plate onto the center of the 96-well base.
Load the reaction plate as desired.

Remove a single optical adhesive film (film) from the box.

Fold back one of the end-tabs. Hold the film with its backing
side up.

. In one continuous movement, peel back the white

protective backing from the center sealing surface. Do not
touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may result in
haziness, but does not affect results. Haziness disappears when the film comes
into contact with the heated cover in the instrument.

While holding the film by the end-tabs, lower the film onto
the reaction plate (adhesive side facing the reaction plate).
Be sure the film completely covers all wells of the reaction
plate. IN

While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good - ,
contact between the film and the entire surface of the IS =
reaction plate. ~

. While using the applicator to hold the edge of the film in O
place, grasp one end of the end-tab and pull up and away / NS >
sharply. Repeat for the other end-tab. —

Repeat step f to ensure a tight, evaporation-free seal. N
While applying firm pressure, run the edge of the
applicator along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight seal.

Inspect the reaction plate to be sure all wells are sealed. You should see an
imprint of all wells on the surface of the film.

For More For more information on:

Information

» Preparing the reaction plate — Refer to the protocol appropriate for the reagents you
are using in the PCR reactions:

— TagMan® Gene Expression Assays Protocol

— Custom TagMan® Gene Expression Assays Protocol

* Consumables — See “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout — See page 98.
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This chapter covers:

B Chapter OVerVIBW . . . ottt ettt e e e e e et e ettt 56
B Prepareforthe Run....... ... ... ... . . 57
B Enable the Notification Settings (Optional) . .. ........................... 59
B Startthe Run. . ... ... . . . 61
B Monitorthe Run . ... ... .. . 61
B Unload the Instrument . ........... .. .. .. it 63

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems 7500/7500 Fast
Real-Time PCR System.

Example Start Experiment
Experiment v

Workflow Design the Experiment (Chapter 2)

v
Prepare the Experiment (Chapter 3)

v
Run the Experiment (Chapter 4)

. Prepare for the run.

. (Optional) Enable the notification settings.
. Start the run.

. Monitor the run.

a A W N =

. Unload the instrument.

v
Analyze the Experiment (Chapter 5)

v
End Experiment

Notes
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Prepare for the Run

Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the 7500/7500 Fast instrument.

Open the 1. Double-click 3 (7500 software) or select Start » All Programs » Applied
Example Biosystems » 7500 Software » <software name>
Experiment where <software name> is the current version of the 7500 software.
2. In the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder (default):

<drive>:\Applied Biosystems\<software name>\experiments

4. Double-click Standard Curve Example Setup.eds to open the example experiment
file that you created in Chapter 2.

Load the AWARNING PHYSICAL INJURY HAZARD. During operation, the sample

Reaction Plate block can be heated to 100 °C. Before performing the following procedure, be sure to
Into the  wait until the sample block reaches room temperature.
Instrument

@ﬂ" ] IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

7500 system 7500 Fast system

Load standard plates with Load Fast plates with the
the notched A12 position at notched A1 position at the
the top-right of the tray. top-left of the tray.

Notes
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Prepare for the Run

3. Place the reactions in the precision plate holder (PPH). If you use:
* A reaction plate — Place the reaction plate in the PPH with well A1 at the

back-left corner.

Note: Fast Reaction 8-tube strips can be used only on the 7500 Fast system.
For the 7500 system, use MicroAmp® Optical 8-Tube Strips.

Reaction tube strips — Place the tube strips in the PPH for tube strips.

Note: Fast Reaction tubes cannot be used in the 7500 Fast system.

Reaction tubes — Place the tubes in the PPH.

Note: MicroAmp® Fast Reaction Tubes (PN 4358297) cannot be used in the
7500 Fast system.

IMPORTANT! For optimal performance with partial loads:

For a 7500 Instrument

Load at least 16 tubes, arranging them first in the center columns of the
instrument system (columns 6 and 7). Move outward towards columns 1 and 12
as you add more tubes.

For a 7500 Fast Instrument

* Place empty tube strips in columns 1 and 12 to prevent crushing of tubes
containing samples.

* Place tube strips with samples in the PPH vertically, starting in columns 6
and 7 and moving outward.

* A maximum of 6 tube strips can be used in the 7500 Fast instrument.
Leave columns 2, 3, 10, and 11 empty.

4. Close the tray door. Apply pressure to the right side of the tray and at an angle.
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Enable the Notification Settings (Optional)

Enable the notification settings so that the 7500 software alerts you by e-mail when the
7500/7500 Fast instrument begins and completes the run, or if an error occurs during the
run. Enabling the notifications settings is optional and does not affect the performance of
the 7500/7500 Fast system or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that you
are using is running the 7500/7500 Fast instrument and is connected to an Ethernet network.

About the In the example experiment:
Example .

! The 7500 software is set up to send notifications to three users (scientist, supervisor,
Experiment

and technician at mycompany.com) when the 7500/7500 Fast system ends the run
and if it encounters any errors during operation.

* The example SMTP server (www.mycompany.com) is set up for secure sockets
layer (SSL) encryption and requires authentication for use.

—h

Set Up the
Notification
Settings

. In the 7500 software, click ™8 Ryn in the navigation pane.
Click (5 Notification Settings.

Select Yes for Enable Notifications.

P 0D

Select the events that will generate notifications:
a. Select Instrument Error.

b. Select Run Completed.

5. In the Enter e-mail addresses for notifications field, enter:
scientist@mycompany.com, supervisor@mycompany.com,
technician@mycompany.com.

6. Inthe Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.

7. Set the authentication settings:

a. Select Yes for Server requires authentication.

b. In the User Name field, enter Example User.

c. In the Password field, enter password.

Notes
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7a

7b
7c

Notification Settings

Enable Motifications: @ ¥es O Mo

7SE|EEHhE events to generate nofifications Instrument Error

[] Run Started

Run Completed

Cnter e-mail addresses for notifications: | scientist@mycompany.com, supervisor@mycompany.com, technician@mycompany.com
Separate e-mail addresses with commas.
For example: jane_smith@mydomain.com,awong@bigmailhost.com

Outgoing Mail Server (SMTP) ‘ smtp.mycompany.com
For example: smtp.mycompany.com

Server requires an encrypted connection? O Yes (2 Mo

1
Server requires authentication? (2 Yes (Mo

(Server Authentication) User Name: | Examplz User |

(Server Authentication) Passward: | " |

Run Guidelines When you set up the 7500/7500 Fast system for automatic notification:

Notes

* Your system must be set up for network use. Refer to the Applied Biosystems 7500/7500
Fast Real-Time PCR Systems Maintenance Guide.

» Select the events for which you want to receive e-mail notifications. Select:

— Instrument Error — To notify recipients by email of all errors encountered by
the instrument during each run.

— Run Started — To notify recipients by email when the instrument starts a run.

— Run Completed — To notify recipients by email when the instrument completes a
run.

¢ Obtain e-mail addresses to receive notifications.

IMPORTANT! Separate addresses with a comma (,).

» Contact your systems administrator or information technology department if you
need:

E-mail addresses for users who will receive notifications

A network address for a simple mail transfer protocol (SMTP) server on the LAN

A user name and password for the server, if required for access
— The Secure Sockets Layer (SSL) setting of the server (on or off)

60
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Start the Run

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not create
experiments, perform maintenance, or allow the computer to run antivirus software or to
enter hibernation mode. Performing such activities while the instrument is running an
experiment will cause gaps in data collection.

To start your 7500/7500 Fast instrument:
1. In the 7500 software, click ™8 Ryn  in the navigation pane.

2. Click START RUN .

Monitor the Run

You can view the progress of the run in real time as described below. During the run,
periodically view all three available plots from the 7500 software for potential problems.

To... Action

Stop the run 1. In the 7500 software, click STOP RUN.

2. In the Stop Run dialog box, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

— Cancel to continue the run.

View amplification data | Select w Amplification Plot.

in real time See “About the Amplification Plot Screen” on page 61.
View progress of the Select |~ Run Method.

run in the Run Method See “About the Run Method Screen” on page 62.
screen

Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “Enable the Notification Settings (Optional)” on page 59.

About the Ampilification Plot Screen

The screen displays sample amplification as your instrument collects fluorescence data
during a run. If a method is set up to collect real-time data, the Amplification Plot screen
displays the data for the wells selected in the View Plate Layout tab. The plot displays
normalized dye fluorescence (ARn) as a function of cycle number. The figure below
shows the Amplification Plot screen as it appears during the example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in
the View Plate Layout tab.

Notes
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Monitor the Run
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Cycle

The Amplification Plot screen is useful for identifying and examining abnormal
amplification. Abnormal amplification can include:

* Increased fluorescence in negative control wells.
» Absence of detectable fluorescence at an expected cycle (determined from previous
similar experiments that were run using the same reagents under the same conditions).

If you notice abnormal amplification or a complete absence of florescence, troubleshoot
the error as explained in the 7500 Software Help (click @ or press F1).

About the Run Method Screen

The screen displays the run method selected for the run in progress. The software updates
the Run Status field throughout the run. The figure below shows the Run Method screen
as it appears in the example experiment.

To... Action

A | Change the number of cycles In the Extend # of Cycles field, enter the number of
cycles to apply to the Cycling Stage.

B | Apply your changes Click Send to Instrument.
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Unload the Instrument

Run Method Edit Run Method

I a Extending cycles is only
Pre-PCR Read (Holding Stage) Holding Stage Cycling Stage PostPC] allowed when the last
l:l stage is a cycling stage that
collects data
Enable AutoDelta
Extend # of Cycles: A
Starting Cycle: 2 | —|:
l Send to Instrument %7 B
100 —|
[T — —
75 —| \
—
50 —| v v
26 —|
0
Step 1 Step 1 Step 1 Step 2
< | b3
Legend
Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off ‘

If an alert appears, click the error for more information, then troubleshoot the problem as
explained in the 7500 Software Help (click @ or press F1).

Unload the Instrument

When your 7500/7500 Fast system displays the Run Complete message, unload the
reaction plate from the instrument.

Unload the AWARNING PHYSICAL INJURY HAZARD. During operation, the sample

Reaction Plate block can be heated to 100 °C. Before performing the following procedure, be sure to
wait until the sample block reaches room temperature.

1. Push the tray door to open it.
2. Remove the reaction plate.

3. Push the tray door to close it.

Notes
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Unload the Instrument

Notes
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Chapter 5

Analyze the Experiment

This chapter covers:

B Chapter OVeIVIEW . . . oottt ettt e e e ettt e et et 66
Section 5.1 Review Results..........c.oiiiiiiiiiiiiiiiiiiiiiiinenens. 67
B Analyze the Experiment . . ............. .ttt 68
B Viewthe Standard Curve . ...ttt 71
B View the Amplification Plot. .. ... ... .. .. ... .. .. .. .. . 74
B Viewthe Well Table .. ... ... ... . e 81
B PublishtheData ........ ... . . . . . . 83
Section 5.2 Troubleshoot (If Needed) ...........cciiiiiiiiiiiinnnnnn. 85
B View the Analysis Settings. ... ...ttt e 86
B View the QC SUMMAIY. . ... oottt e e e e e 88
B Omit Wells from the Analysis. .. ........... i, 90
B View the Multicomponent Plot. . ......... .. ... ... .. .. ... .. 92
B Viewthe Raw DataPlot .. ........ ... ... . i 94

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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Chapter Overview

The 7500 software analyzes the data using the standard curve quantitation method.
Section 1 of this chapter explains how to review the analyzed data using several of the
analysis screens and how to publish the data. If you obtain questionable results, Section 2
of this chapter explains how to perform some troubleshooting steps.

Example Start Experiment
Experiment A 4
Workflow Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

Section 1, Review Results:

. Analyze.

. View the standard curve.

. View the ampilification plot.

. View the results in a table.

. Publish the data.

Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the baseline/threshold.

a b~ W N =

2. View the quality summary.
3. Omit wells.
4. View the multicomponent plot.
5. View the raw data plot.
End Experiment
Notes
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Section 5.1 Review Results

This section covers:

B Analyze the Experiment . ... ............ it 68
B Viewthe Standard Curve . ....... ... . . . . 71
B View the Amplification Plot. .. ...... ... ... ... . . . . 74
B Viewthe Well Table . . ... ... . . . 81
B PublishtheData ......... ... .. . . . e 83
Notes
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Analyze the Experiment

The 7500 software analyzes the experiment and displays results in the analysis screens
(for example, the Amplification Plot screen, QC Summary screen, and so on).

About the For the standard curve example experiment, use the data file that is installed with the
Example 7500 software. The data file was created with the same design parameters that are
Experiment provided in Chapter 2, then run and analyzed on a 7500/7500 Fast instrument. You can
find the data file for the example experiment on your computer at:

<drive>:\Applied Biosystems\<software name>\experiments\

Standard Curve Example.eds

where:
» <drive> is the computer hard drive on which the 7500 software is installed.
»  <software name> is the current version of the 7500 software.

Analyze the 1. Double-click g (7500 software) or select Start » All Programs » Applied
Example Biosystems » 7500 Software » <software name>
Experiment

where <software name> is the current version of the 7500 software.
2. In the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder at:

<drive>:\Applied Biosystems\<software name>\experiments

4. Double-click Standard Curve Example.eds to open the example experiment data
file.

Note: The experiments folder contains several data files; be sure to select Standard
Curve Example.eds.

5. In the navigation pane, click Analysis. The 7500 software analyzes the data using
the default analysis settings.

See “Navigation Tips” on page 69 for information on navigating within the analysis
screens.

File Edit Instrument Analysis Tools Help

[] NewExperiment - [5 Open.. [ Save - £ Close . Export.~ [} PrintReport..

Experiment Menu <« | Experim... standard curve example experime Ty... Standard Curvi Reage... TagMan® Reagents |[EUcle=s

' Setup Amplification Plot <[ View Plate Layout | View Wel Table |
Plot Setings 4 Select Wells With: - Select tem - v | |
PlotType: ARnvs Cycle v | Graph Type:|Log  ~| Plot Color:|wen ~| = =
| Elslmwmwmls' | VlewLEgEnd | |
2 £ & iy & =
Amplification Plot £ F 8 I: )

2 g 4 5 B 7 8 g
A e e

Standard Curve 10 Amplification Plot
] i

Notes
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Analyze the Experiment

Guidelines When you analyze your own standard curve experiment:

* Immediately after a run, the 7500 software automatically analyzes the data using the
default analysis settings, then displays the Amplification Plot screen on your
computer.

» To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Navigation Tips How to Select Wells

To display specific wells in the analysis screens, select the wells in the View Plate Layout
tab as follows:

1. To select wells of a specific type, using the Select Wells With drop-down lists, select
Sample, Target, or Task, then select the sample, target, or task name.

2. To select a single well, click the well in the plate layout.

3. To select multiple wells, click-drag over the desired wells, or CTRL+click, or
Shift+click the desired wells in the plate layout.

4. To select all 96 wells, click the upper left corner of the plate layout.

»| View Plate LayoutT View Well Table ]

SelectWells With: | Select ltem - v—| |

[ View Legend

| [37] showinwells ¥ |

1 2 3 4 il 6 7 8 9 10 11 12
1
: (s

=

H

Wells mﬁ Unknown B 15 Standard DS Megative Control 72 Emptly

Notes
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Notes

Analyze the Experiment

How To Display Multiple Plots

Use the Multiple Plots screen to display up to four plots simultaneously. To navigate

within the Multiple Plots screen:

1. In the navigation pane, select Analysis » |E%| Multiple Plots View.

2. To display four plots, clic

55 (Show plots in a 2 X 2 matrix).

3. To display two plots in rows, click = (Show plots in two rows).

4. To display two plots in columns, click ||| (Show plots in two columns).

5. To display a specific plot, select the plot in the drop-down list above each plot

display.
El=mn1—4
S —
[mpiification Pot - ARn vs cycle v| ‘Standard Curve v
n "k —. —
£ P alR ! B R =
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. n_
1 =
=7, 11
- 0.01 s HHE i f -‘,,_-
& - L= —m — : > sfizsenh ==
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Legerd
Cyele g Standard m Unknown
Leged
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View the Standard Curve

The Standard Curve screen displays the standard curve for samples designated as
standards. The 7500 software calculates the quantity of an unknown target from the
standard curve.

About the In the standard curve example experiment, you review the Standard Curve screen for the
Example following regression coefficient values:

Experiment * Slope/amplification efficiency
+ RZvalue (correlation coefficient)

* C;pvalues

Note: In the example experiment, the slope, R?, and amplification efficiency values are
affected by the C of well B12 which you will omit later in this guide.

View the 1. In the navigation pane, select Analysis » Standard Curve.

Standard Curve
Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the Standard Curve screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.

3. In the Target drop-down list, select All.

4. In the Plot Color drop-down list, select Default.

5. Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

6. View the values displayed below the standard curve. In the example experiment, the
values for the target (RNase P) are within the acceptable ranges:

— The slope is -3.685.
— The R? value is 0.992.
— The amplification efficiency (Eff%) is 86.81%.

Notes
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View the Standard Curve

7. Check that all samples are within the standard curve. In the example experiment, all

samples (blue dots) are within the standard curve (red dots).

Standard Curve

Plot
3 Target Plot Color |Default -
ave current settings as the default ‘
4 |
By 2 = 4—5
Standard Curve
31.0 ™
30.5
30.0
285
28.0
5 =8s - 7
28.0
275
27.0
285
26.0 |
1000 10000
Quantity
6 Target: RNase P TAMRA Slope: -3.685 Y-Inter: 40.966 Bz: 0.992 Eff%: 86.81 =
Legend
[. Standard . Unknown . Unknown (Flagged) %
8. Check the C; values:
a. Select the View Well Table tab.
b. In the Group By drop-down list, select Replicate.
c. Observe the values in the C; column. In the example experiment, the C; values
are within the expected range (>8 and <35).
8a
View Plate Layout | View Well Table W
8b | SelectWells with: - Selectitem - v |
[ snowinTapie v | sroupay v | xpand All | 5 collapse Al |
‘
[ 8c
#F | Well Omit Flag Sample.. TargetN.. | Task Dyes ot CTMean CTSD Quantity Quantity... = Quantity.. | !
= RMNase P TAMEA - N'TC o]
1 Al - EMase P T.. NTC FAM-TAMRA LUndetermi
2 A2 - EMase P T.. NTC FAM-TAMRA LUndetermi
3 A3 O EMNase P T.. NTC FAM-TAMRA LUndetermi
= RMase P TAMEA - STANCARD - 10000.0
4 AlD - FEMNase P T.. STANDARD FAM-TAMRA 26.389278 26.281769 0.094 10,000
] Al1 - FEMNase P T.. STANDARD FAM-TAMRA 26.213354 26.281769 0.094 10,000
6 Al2 O FEMNase P T.. STANDARD FAM-TAMRA 26.242676 26.281769 0.094 10,000 ==
= RMase P TAMEA - STANCARLD - 1250.0
7 BY - FEMNase P T.. STANDARD FAM-TAMRA 29.64913 20.538963 0114 1,250
8 BE ] RNase P T.. STANDARD FAM-TAMRA 29546368 29.538963 0114 1,250
9 B9 a RNase P T.. STANDARD FAM-TAMRA 29.421392 29.538963 0114 1,250
= RMase P TAMEA - STANCARD - 2500.0
10 B4 I | RMNase P T.. STANDARD FAM-TAMRA 28.325405 28.434366 0.228 2,500
11 BS I | RMNase P T.. STANDARD FAM-TAMRA 28.28138 28.434366 0.228 2,500
12 BE& a RNase P T.. STANDARD FAM-TAMRA 2B8.69632 28.434366 0.228 2,500
= RMase P TAMEA - STANCARD - 5000.0
13 B1 I | RNase P T.. STANDARD FAM-TAMRA 27.36778 27.277845 0.082 5,000
14 B2 I | RMNase P T.. STANDARD FAM-TAMRA 27.258842 27.277845 0.082 5,000
Notes
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Analysis When you analyze your own standard curve experiment, look for:

Guidelines » Slope/amplification efficiency values — The amplification efficiency is calculated

using the slope of the regression line in the standard curve. A slope close to —3.3
indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency are:

— The range of standard quantities — For more accurate and precise efficiency
measurements, use a broad range (103 to 10° fold) of standard quantities.

— The number of standard replicates — For more accurate efficiency measurements,
include replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can reduce amplification
efficiency.

+ R? values (correlation coefficient) — The R? value is a measure of the closeness of
fit between the regression line and the individual C; data points of the standard
reactions. A value of 1.00 indicates a perfect fit between the regression line and the
data points. An R? value >0.99 is desirable.

* Cj values — The threshold cycle (Cy) is the PCR cycle number at which the
fluorescence level meets the threshold. A C value >8 and <35 is desirable. A C
value <8 indicates that there is too much template in the reaction. A Cy value >35
indicates a low amount of target in the reaction; for C; values >335, expect a higher
standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Omit Wells from the Analysis” on page 90).

or

* Rerun the experiment.

For More For more information on:

Information * The Standard Curve screen — Open the 7500 Software Help by clicking @) or
pressing F1.
+ Amplification efficiency — Refer to the Amplification Efficiency of TagMan® Gene
Expression Assays Application Note.
Notes
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View the Amplification Plot

View the Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected wells.
Three plots are available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence generated by the
reporter at each cycle during the PCR amplification. This plot displays ARn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence from the reporter dye normalized to the
fluorescence from the passive reference. This plot displays Rn as a function of cycle
number. You can use this plot to identify and examine irregular amplification.

* C;vs Well - C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays Cy as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be displayed on a linear or log10 scale.

About the In the standard curve example experiment, you review the target in the Amplification
Example Plot screen for:

Experiment ¢ Correct baseline and threshold values
¢ Qutliers

View the 1. In the navigation pane, select Analysis » Amplification Plot.

Amplification Plot
Note: If no data are displayed, click Analyze.

2. Display the RNase P wells in the Amplification Plot screen:
a. Select the View Plate Layout tab.

b. In the Select Wells With drop-down lists, select Target, then RNase P
TAMRA.

28— View Plate Layout T WView Well Table } I 2b

)
SelectWells With: - Selecthem- | ‘
| B | show in wells ¥ | View Legend

1 2 3 4 5 B T a 9
--
S 1
i e

EE

+,
|

=

G

3. Inthe Amplification Plot screen:
a. In the Plot Type drop-down list, select ARn vs Cycle (default).
b. In the Plot Color drop-down list, select Well (default).

Notes
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View the Amplification Plot

c. Click *= (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button
changes to Hide the plot legend.

4. View the baseline values:
a. In the Graph Type drop-down list, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescence is detected. In
the example experiment, the baseline is set correctly.

3a 4a 3b

Plot

| |
Plot Typs:[Rn vs Cycle | Graph Type:[Linzar | Plot Color: [well ~

Save current settings as the default

PP el = 3¢

Amplification Plot

Legerd
A B Mlc Mp ME HrF Hc HH

Options
Target [RNase P TAMRA | Threshold: [7] Auto Auto Baseline
4b Show "rﬁ?éé’h’ii]&—[g Baseline Start Well B Target 4 Baseline End: Well /B Target 4.
Notes
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View the Amplification Plot

5. View the threshold values:
a. In the Graph Type drop-down list, select Log.
b. In the Target drop-down list, select RNase P TAMRA.

c. Select the Threshold check box to show the threshold.
d. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.
5a
Plot Type:/aRn vs Cycle | Graph Type:[Log | Piot cotor:[wan ~]
Save current seftings as the default
AP iy = =
oo Amplfieation Plet
' LAs3s2
0.1
0.01
g 0.001 m/. /\
0.0001 \
0.00001
0.000001
0.0000001
Cycle
{-&A B Mlc Mp e Hfr Hc HH
Options
Target Threshold [ Auto Auto Baseline
5b
5C Show: [¥] Threshold — [[] Baseline Start: Well B Target . Baseline End: Well (B Target 4
Notes
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View the Amplification Plot

6. Locate any outliers:
a. In the Plot Type drop-down list, select Cy vs Well.

b. Look for outliers in the amplification plot. In the example experiment, there are
no outliers for RNase P.

6a
Plot Type:|C1vs Well | Graph Type |L1-:l | Plot Color. |We|l v‘

Save current seftings as the default

Amplification Plot

5
’ ) N ‘Well Number " -
-;‘T B Mc D ME HrF Hc HH
Notes
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View the Amplification Plot

Analysis When you analyze your own standard curve experiment, look for:
Guidelines . Qutliers

* A typical amplification plot — The 7500 software automatically calculates baseline
and threshold values based on the assumption that the data exhibit a #ypical
amplification plot. A typical amplification plot has four distinct sections:

a. Plateau phase
b. Linear phase

c. Exponential (geometric phase)

d. Baseline
10
}
0.210658
o1 .Threshold
ARN
oo

0.001

o A A i
3 B ¥ . }[u,
L SN M ! i [~

4 a a 10 12 | 4 1R | WM MW W W M A1 AP AU S W 4N 49

Cycle

0.0001

d

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the 7500 software. Therefore, Applied Biosystems
recommends that you examine the Amplification Plot screen and review the
assigned baseline and threshold values for each well after analysis is complete.

* Correct baseline and threshold values — See the threshold examples on page 79 and
the baseline examples on page 80.
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View the Amplification Plot

Threshold Set Correctly

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum increase
the standard deviation of the replicate groups.

Task

Dyas

cr

CTMan cTs0 Quatey Quuartey Quuairey Commi
HTC FAMENFG-.. Undéteimi_.
HTC FAMHFO-.. Undstemi..
TG FAMENFQ-.. Undstaami..
UNKMNOWN FAM-NFO-.. 2096287 20923796 0074 248431 2551478 1262
UREMOWH FAM-NFO-.. 28838787 28823705 0074 2667054 2EE14TE 1282
UNEMNOWN  FAM-NFO-. 2004572 20.0237T08 0.074 2472084 2EE14TE 182

Threshold Set Too Low

The threshold is set below the exponential phase of the
amplification curve. The standard deviation is significantly
higher than that for a plot where the threshold is set
correctly. Drag the threshold bar up into the exponential
phase of the curve.

Task

0.242796.

Dyas cr €1 Maan CTE0 Quantey Quansy Quantey

NTC FAM-NFG-... Undetermi..

NTE FAM-NFQ-.. Undstermi..

NTC FAM-NFG-.. 38453182

UNKNOWN FAN-NFQ-. 2285404 22760744 0.252 2314852 2ATINE3 400435

UNKNCWH FAM-NFG-. 22476873 22761744 0262 2827722 2472483 400435

UNKNOWH FAN-NFO-.. 22854218 22761744 0252 2074818 24T2463  400.435

Threshold Set Too High 0 5

The threshold is set above the exponential phase of the
amplification curve. The standard deviation is significantly
higher than that for a plot where the threshold is set -
correctly. Drag the threshold bar down into the '
exponential phase of the curve.

L.754743

0.1 §

Task Dyes

cr

CrMean  CTSD Ouantsy Ouanitiy Ouantiy Comma =

NTC FAMCNFG-.. Undetemi.. =

HTG FAM-NFOQ- Uncetemi_.

HTC FAMNFG-. Unietemil_. 001
UNKNOWH FAM-NFO-. 37681107 37.48507 0202 2571477 288042 363775

UNSKNOWH FAM-NEQ-. 3737671 3749507 0202 3360023 2880428  MITIE

UNSNOWH FAM-NFQ- . 37524305 3749507 0202 2820187 2880435 35315

Notes
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View the Amplification Plot

Baseline Examples

Baseline Set Correctly

The amplification curve begins after the maximum
baseline.

Baseline Set Too Low

The amplification curve begins too far to the right of the
maximum baseline. Increase the End Cycle value.

Baseline Set Too High

The amplification curve begins before the maximum
baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above:
* Omit wells (see “Omit Wells from the Analysis” on page 90).
or

* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 86).

For More For more information on the Amplification Plot screen, open the 7500 Software Help by
Information clicking @) or pressing F1.

Notes
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View the Well Table

View the Well Table

The Well Table displays data for each well in the reaction plate, including:
» The sample name, target name, task, and dyes

* The calculated threshold cycle (Cy), normalized fluorescence (Rn), and quantity
values

¢« Comments

* Flags

About the In the standard curve example experiment, you review the Well Table for:
Example .

A Quantity values
Experiment

* Flags
* C; values (including C; standard deviation)

View the Well 1. In the navigation pane, select Analysis, then select the View Well Table tab.

Table
Note: If no data are displayed, click Analyze.

2. Use the Group By drop-down list to group wells by a specific category. For the
example experiment, group the wells by replicate, flag, or C value.

Note: You can select only one category at a time.

a. In the Group By drop-down list, select Replicate. The software groups the
replicate wells: negative controls, standards, and samples. In the example
experiment, note that the quantity values within each replicate group are similar.

Note: To move a column, drag the column heading.

View Plate Layout | View Well Table ]

2a ‘ SelectWells With: |- Selectitem - »
. |
[ show nTasie v | eroupsy v | ‘ Expand Al | Callapse Al |
.
# 0 Well omit Flag Sample TargetM... | Task Dyes CT CTMean CTSD Quantity Quantity... | Quantity... | 1
= RNase P TAMRA - NT'C il
1 Al [~ | RMase P T... NTC FAM-TAMRA Undetermi...
& A2 [~ | RMase P T... NTC FAM-TAMRA Undetermi...
3 A3 ] RMase P T... NTC FAM-TAMRA Undetermi...
= RNase P TAMRA - STANCART - 10000.0
4 A10 [~ | RMase P T.. STANDARD FAM-TAMRA 26389278 26.281769 0.094 10,000
a A1l [~ | RMase P T.. STANDARD FAM-TAMRA 26213354 26.281769 0.094 10,000
] A12 ] RMase P T.. STANDARD FAM-TAMRA 26242676 26.281769 0.094 10,000
= RNase P TAMRA - STANDARL - 12500
7 B7 [~ | RMase P T.. STANDARD FAM-TAMRA 29.64813 289538063 0114 1,260
8 B3 [~ | RMase P T.. STANDARD FAM-TAMRA 28546368 29.538963 0114 1,260
g BS ] RMase P T.. STANDARD FAM-TAMRA 28421382 29.538963 0114 1,260
= RNase P TAMRA - STANDARL - 2500.0
10 B4 [~ | RMase P T.. STANDARD FAM-TAMRA 28325405 28.434366 0.228 2,500
11 BS [~ | RMase P T.. STANDARD FAM-TAMRA 2828138 28.434366 0.228 2,500
12 BE ] RMase P T.. STANDARD FAM-TAMRA 28.69632 28.434366 0.228 2,500
= RNase P TAMRA - STANDARL - 5000.0
Notes
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve 81

Experiments



View the Well Table

Chapter 5 Analyze the Experiment

b. In the Group By drop-down list, select Flag. The software groups the flagged
and unflagged wells. In the example experiment, well B12 is flagged.

[ View Plate Layout | View Well Table |

2b SelectWells With: |- Selectitem -+
‘
| Show in Table ¥ | Group By ¥ ‘ wpand All Collapse All
\
# | Well omit Flag Sample.. TargetM.. Task Dyes cT CT Mean CcTSD Quantity Quantity... | Quantity... | |
= Flagged Wells |
1 B12 O RNase P T. STANDARD FAM-TAMRA 30.982454 30697205 0247 625
= Unflagged Wells
2 Al o RNase P T.. NTC FAM-TAMRA Undetermi
3 A2 O RNase P T... NTC FAM-TAMRA Undetermi
I A3 O RNase P T... NTC FAM-TAMRA Undetermi
5 Al O papt RNase P T.. UNKNOWN FAM-TAMRA 28.280773 28260696 002 2772365  2,807.509 34422
6 A5 O papt RNase P T.. UNKNOWN FAM-TAMRA 28.241540 28260696 002 2841162  2,807.509 34422
7 A6 O papt RNase P T.. UNKNOWN FAM-TAMRA 28.259768 28.260696 002 2808998  2,807.509 34422
8 AT O pop2 RNase P T.. UNKNOWN FAM-TAMRA 27.241302 27.200424 0036 5308388 5446654 121319
g AB O pop2 RNase P T.. UNKNOWN FAM-TAMRA 27.18564  27.200424 0036 5496287 5446654 121319
10 Ag O pop2 RNase P T.. UNKNOWN FAM-TAMRA 27.174326 27.200424 0036 5535287 5446654 121319
11 A1D O RNase P T.. STANDARD FAM-TAMRA 26389278 26281769 0.094 10,000
12 A1 O RNase P T.. STANDARD FAM-TAMRA 26213354 26281769 0.094 10,000
13 A12 O RNase P T.. STANDARD FAM-TAMRA 26242676 26281769 0.094 10,000
14 B1 O RNase P T. STANDARD FAM-TAMRA 27.36778  27.277845 0.082 5,000
15 B2 O RNase P T.. STANDARD FAM-TAMRA 27.258842 27.277845 0.082 5,000
16 B3 O RNase P T.. STANDARD FAM-TAMRA 27.206913 27.277845 0.082 5,000
17 B4 O RNase P T.. STANDARD FAM-TAMRA 28.325405 28.434366 0228 2,500
18 B5 O RNase P T. STANDARD FAM-TAMRA 28.28138  28.434366 0228 2,500
13 B6 O RNase P T.. STANDARD FAM-TAMRA 28.69632  28.434366 0228 2,500
20 B7 O RNase P T.. STANDARD FAM-TAMRA 29.64913 20533963 0114 1,250
21 BE O RNase P T.. STANDARD FAM-TAMRA 29.546368 20533963 0114 1,250
22 BY O RNase P T.. STANDARD FAM-TAMRA 29.421392 20533963 0114 1,250
23 B10 O RNase P T.. STANDARD FAM-TAMRA 30.557467 30697205 0247 625
2 B11 O RNase P T.. STANDARD FAM-TAMRA 30.551697 30697205 0247 625
25 c O
el o7 I L]
< >
c. Inthe Group By drop-down list, select C. The software groups the wells by C
value: low, medium, high, and undetermined. In the example experiment, the
C; values are within the expected range (>8 and <35).
View Plate Layout | View Well Table ]
2c | SelectWalls With: - Selectitem- v
| Show in Table ¥ | Graup By ¥ ‘ Expand Al Gollapse All
‘
# | Well Omit Flag Sample Target N Task Dyes Cr CT Mean CT5D Quantity Quantity Quantity |
Lowr (Cr less than 24) )
= Medinm (Cr from 24 to 30)
1 Al 0 popt RNase P T.. UNKNOWN FAM-TAMRA 28.280773 28.260696 002 2772385 2,807.509 34422
2 A5 O popt RNase P T.. UNKNOWN FAM-TAMRA 28.241543 28260696 002 2841162  2,807.509 34422
3 AB O popt RNase P T.. UNKNOWN FAM-TAMRA 28.259768 28.260696 002 2808998  2,807.509 34422
1 AT O pop2 RNase P T.. UNKNOWN FAM-TAMRA 27.241302 27.200424 0036 5308388 5446654 121318
5 A8 O pop2 RNase P T.. UNKNOWN FAM-TAMRA 27.18564  27.200424 0036 5496287 5446654 121318
6 A9 O pop2 RNase P T.. UNKNOWN FAM-TAMRA 27.174328 27.200424 0036 5535287 5446654 121318
7 A1D O RNase P T.. STANDARD FAM-TAMRA 26389278 26.281769 0.094 10,000
8 A1 O RNase P T.. STANDARD FAM-TAMRA 26.213354 26.281769 0.094 10,000
g A12 O RNase P T.. STANDARD FAM-TAMRA 26.242676 26.281769 0.094 10,000
10 B1 O RNase P T.. STANDARD FAM-TAMRA 27.36778  27.277845 0.082 5,000
1 B2 O RNase P T.. STANDARD FAM-TAMRA 27.258842 27.277845 0.082 5,000
12 B3 O RNase P T.. STANDARD FAM-TAMRA 27.208813 27.277845 0.082 5,000
13 B4 O RNase P T.. STANDARD FAM-TAMRA 28.325405 28.434366 0228 2,500
14 B5 O RNase P T.. STANDARD FAM-TAMRA 28.28138  28.434366 0228 2,500
15 B6 O RNase P T.. STANDARD FAM-TAMRA 28.63632  28.434366 0228 2,500
18 B7 O RNase P T.. STANDARD FAM-TAMRA 29.64913 20538963 0114 1,250
17 B8 O RNase P T.. STANDARD FAM-TAMRA 29.546388 20533963 0114 1,250
18 B9 O RNase P T.. STANDARD FAM-TAMRA 29.421392 20538963 0114 1,250
=l High (Ct greater than 30)
19 B10 0 RNase P T.. STANDARD FAM-TAMRA 30.657467 30697205 0.247 625
20 B11 O RNase P T.. STANDARD FAM-TAMRA 30.551697 30697205 0.247 625
21 B12 O 1 RNase P T.. STANDARD FAM-TAMRA 30.982454 30697205 0.247 625
= Undetermined
22 Al I~ | RMNase P T... NTC FAM-TAMRA Undetermi
23 A2 I~ | RMNase P T... NTC FAM-TAMRA Undetermi
u,om m RNasePT NTG FAM-TAMRA Undefermi - ~
Notes
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Publish the Data

Analysis  When you analyze your own standard curve experiment, group the wells by:

Guidelines * Replicate — The software groups the wells by replicate: negative controls,
standards, and samples. Look in the Quantity columns to make sure the quantity
values for each replicate group are similar. This indicates tight precision.

» Flag — The software groups the flagged and unflagged wells. A flag indicates that
the software found an error in the flagged well. For a description of the 7500
software flags, see “View the QC Summary” on page 88.

* C; — The threshold cycle (C;) is the PCR cycle number at which the fluorescence
level meets the threshold. A C value >8 and <35 is desirable. A C; value <8 indicates
that there is too much template in the reaction. A C value >35 indicates a low amount
of target in the reaction; for C; values >35, expect a higher standard deviation.

For More  For more information on the Well Table, open the 7500 Software Help by clicking ) or
Information pressing F1.

Publish the Data

You can publish the experiment data in several ways:
* Save the plot as an image file
* Print the plot
* Print the plate layout
* Create slides
* Print a report
* Export data

For information on performing these procedures, open the 7500 Software Help by
clicking @) or pressing F1.

Notes
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Notes
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Section 5.2 Troubleshoot (If Needed)

Section 5.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings. ... ........utiiinn i 86
B View the QC SUMMATIY. . . ..o\ttt ettt e e 88
B Omit Wells from the Analysis. . ......... .. . i, 90
B View the Multicomponent Plot. . .......... ... ... ... ... . . ... 92
B Viewthe Raw DataPlot .. ...... ... .. .. i 94
Notes
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View the Analysis Settings

View the Analysis Settings

About the
Example
Experiment

View the Analysis
Settings

Notes

86

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cyp), flags, and advanced options. If the default analysis settings in the 7500 software are
not suitable for your experiment, you can change the settings in the Analysis Settings
dialog box, then reanalyze your experiment.

In the standard curve example experiment, the default analysis settings are used without
changes.

1. In the navigation pane, select Analysis.
2. Click Analysis Settings to open the Analysis Settings dialog box.

3. In the example experiment, the default analysis settings are specified in the:
* C; Settings tab
* Flag Settings tab
* Advanced Settings tab

E Analysis Settings for standard curve example experiment

[[CTSettings | Flag Ssttings | Advanced Settings |
-
a Review the default settings for analysis oftargets in this experiment. To edit the default settings, click "Edit Default Settings.” To use
different settings for a target, select the target from the table, deselect"Use Default Settings,” then change the settings that are displayed.
Default C1 Settings
Default CT seftings are used to calculate the CT for targets without custom seftings. To editthe default settings, click "Edit Default Settings "
Threshold: AUTO  Baseline Start Cyele: AUTO  Baseling End Gyele: AUTO | Edit Defaul Seftings
Select a Target Cr1 Settings for RNase P TAMRA
Target Threshold Baseline Start Baseline End T Sattings to Use: Use Default Setiings
Rhase P TAMRA  |AUTO AUTO IAUTO e
b
< | ¥
| Revert to Default Analysis Seftings | Apply Analysis Seftings ‘ Cancel
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View the Analysis Settings

Analysis  Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the 7500 software. If the default settings are not suitable for
your experiment, you can change the settings. Use the:

* C; Settings tab to manually set the threshold and baseline. When manually setting the
threshold and baseline, Applied Biosystems recommends the following:

Setting Recommendation

Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline
ends before significant fluorescence is detected.

* Flag Settings tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the 7500 software.

* Advanced Settings tab to change baseline settings well by well.

For More For more information on the analysis settings, open the 7500 Software Help by pressing
Information F1 when the Analysis Settings dialog box is open.

Notes
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View the QC Summary

The QC Summary screen displays a list of the 7500 software flags, and includes the flag
frequency and location for the open experiment.

About the In the standard curve example experiment, you review the QC Summary screen for any
Example flags generated by the experiment data. In the example experiment, well B12 produced a
Experiment C; that deviates significantly from the associated technical replicates, generating the
OUTLIERRG flag and indicating that the well is a potential outlier.

View the QC 1. In the navigation pane, select Analysis » QC Summary.

Summary
Note: If no data are displayed, click Analyze.

2. Review the Flag Summary. In the example experiment, there is 1 flagged well.

3. In the Flag Details table, look in the Frequency and Wells columns to determine
which flag appears in the experiment. In the example experiment, the Frequency
column displays 1 for the OUTLIERRG flag.

Note: A 0 that is displayed in the Frequency column indicates that the flag does not
appear in the experiment.

4. (Optional) Click the OUTLIERRG flag row to display details about the flag.

Flag v
Total Wells: 96 | Processed Wells 24 Manually Omitted Wells 0 | Targets Used: 1
Wells SetUp 24 | FlaggedwWells 1 Analysis Omitted Wells: 0 | Samples Used 2
Flag Details
Flag Mame krequency " welis

4 AMPNC Amplification in negative control 0
BADROX Bad passive reference signal 0
OFFSCALE Fluorescence is offscale 0
HIGHSD High standard deviation in replicate group 0
MNOAMP Mo amplification 0
MOISE Moise higher than others in plate 0
SPIKE Moise spikes 0
MOSIGNAL Mo signal in well 0
OUTLIERRG Outlier in replicate group 1 Bi2
EXPFAIL Exponential algorithm failed 0
BLFAIL Baseline algorithm failed 0
THOLDFAIL Thresholding algorithm failed 0
CTFAIL CT algorithm failed 0

Flag: OUTLIERRG—Outlier in replicate group
Flag Detail: The CT deviates significantly from CT valugs in the associated
replicate group.
Flagged Wells: B12
view OUTLIERRG Troubleshaoting Infarmation
Notes
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View the QC Summary

Possible Flags For standard curve experiments, the flags listed below can be generated by the
experiment data.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is indicated in the Wells

column.
Flag Description

AMPNC Amplification in negative control

BADROX Bad passive reference signal

BLFAIL Baseline algorithm failed

CTFAIL Cy algorithm failed

EXPFAIL Exponential algorithm failed

HIGHSD ' High standard deviation in replicate group

MTP Multiple Tm peaks
Note: This flag is displayed only if the experiment
includes a melt curve.

NOAMP No amplification

NOISE Noise higher than others in plate

NOSIGNAL No signal in well

OFFSCALE Fluorescence is offscale

OUTLIERRG Outlier in replicate group

SPIKE " Noise spikes

THOLDFAIL Thresholding algorithm failed

Analysis When you analyze your own standard curve experiment:

Guidelines * Click each flag in the Flag Details table with a frequency >0 to display details about
the flag. If needed, click the troubleshooting link to view information on correcting
the flag.

* You can change the flag settings:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the 7500 software.

For More For more information on the QC Summary screen or on flag settings, open the 7500
Information  Software Help by clicking @) or pressing F1.

Notes
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Omit Wells from the Analysis

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C; values that differ significantly from the average for the
associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements. To ensure precision, omit the outliers from the analysis.

About the In the standard curve example experiment, well B12 is flagged as a potential outlier.

Example
Experiment

Omit Wells 1. In the navigation pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Inthe Amplification Plot screen, select C vs Well in the Plot Type drop-down list.

3. Select the View Well Table tab.

4. In the Well Table:

a. In the Group By drop-down list, select Replicate.

b. Look for any outliers in the replicate group (be sure they are flagged). In the
example experiment, the 7500 software flagged well B12 as a potential outlier.

3
View Plate Layout | View well Table ]
4a ‘ SelectWells With: |- Selectitem -
. |
[ show nTasie v | eroupsy v | ‘ Expand Al | Callapse Al |
.
# 0 Well omit Flag Sample TargetM... | Task Dyes CT CTMean CTSD Quantity Quantity... | Quantity... | 1
= RNase P TAMERA - NT'C il
1 Al [~ | RMase P T... NTC FAM-TAMRA Undetermi...
& A2 [~ | RMase P T... NTC FAM-TAMRA Undetermi...
3 A3 ] RMase P T... NTC FAM-TAMRA Undetermi...
= RNase P TAMRA - STANCARL - 10000.0
4 A10 [~ | RMase P T.. STANDARD FAM-TAMRA 26389278 26.281769 0.094 10,000
a A1l [~ | RMase P T.. STANDARD FAM-TAMRA 26213354 26.281769 0.094 10,000
] A12 ] RMase P T.. STANDARD FAM-TAMRA 26242676 26.281769 0.094 10,000
= RNase P TAMERA - STANCARL - 1250.0
7 B7 [~ | RMase P T.. STANDARD FAM-TAMRA 29.64813 289538063 0114 1,260
8 B8 [~ | RMase PT.. STANDARD FAM-TAMRA 29546368 29.538963 0114 1,250
a B9 " | RMase P T.. STANDARD FAM-TAMRA 29421392 29.538963 0114 1,250
= RNase P TAMRA - STANDARD - 2500.0
10 B4 ™ | RMase P T.. STANDARD FAM-TAMRA 28325405 28.434366 0.228 2,500
11 BS ™ | RMase PT.. STANDARD FAM-TAMRA 28.28138 28.434366 0.228 2,500
12 BE " | RMase PT.. STANDARD FAM-TAMRA 28.69632 28.434366 0.228 2,500
= RNase P TAMRA - STANDARD - 5000.0
13 B ™ | RMase PT.. STANDARD FAM-TAMRA 27.36778 27.277845 0.0e2 5,000
14 B2 ™ | RMase P T.. STANDARD FAM-TAMRA 27.258842 27.277845 0.0e2 5,000
15 B3 " | RMase P T.. STANDARD FAM-TAMRA 27.206913 27.277845 0.0e2 5,000
=l RNase P TAMRA - STANDARD - 625.0
5 16 B10 [ | RMase P T.. STANDARD FAM-TAMRA 30557467 30.697205 0.247 625
17 B11 [‘] RMase P T.. STANDARD FAM-TAMRA 30551697 30.697205 0.247 625
18 B12 [ 1 RMase P T.. STANDARD FAM-TAMRA 30982454 30.697205 0.247 625
=l popl - RNase P TAMEA - UNENOWN
5. Select the Omit check box next to well B12.
Notes
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Chapter 5 Analyze the Experiment ﬂ
Omit Wells from the Analysis

6. Click Analyze to reanalyze the experiment data with the outlying well(s) removed
from the analysis.

7. Review the data analyzed without the outlier:
a. In the navigation pane, select Analysis » Standard Curve.

b. Display all 96 wells in the Standard Curve screen by clicking the upper left
corner of the plate layout in the View Plate Layout tab.

c. In the Target drop-down list, select All.
d. In the Plot Color drop-down list, select Default.

8. View the values displayed below the standard curve. In the example experiment, the
values for the target (RNase P) are within the acceptable ranges:

— Slope is -3.614.
— RZ?value is 0.993.
— Amplification efficiency (Eff%) is 89.118%.

Analysis  When you analyze your own standard curve experiment, carefully view the replicate
Guidelines  groups for outliers. If needed, remove outliers manually using the Well Table.

For More For more information on omitting wells from the analysis, open the 7500 Software Help
Information by clicking g) or pressing F1. Within the Help, search for the omit well topics:

1. Select the Search tab.
2. Enter omit well.

3. Click List Topics.

4

. Double-click the topics you want to review.

Notes
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ﬂ Chapter 5 Analyze the Experiment
View the Multicomponent Plot

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of the PCR run.

About the In the standard curve example experiment, you review the Multicomponent Plot screen for:

£ Exa_tmpl(i « ROX™ dye (passive reference)
Xperimen + FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes
* Amplification in the negative control wells
View the
Multicomponent 1. In the navigation pane, select Analysis » |2 | Multicomponent Plot.
Plot
Note: If no data are displayed, click Analyze.
2. Display the unknown and standard wells one at a time in the Multicomponent Plot screen:
a. Select the View Plate Layout tab.
b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.
Note: If you select multiple wells, the Multicomponent Plot screen displays
the data for all selected wells simultaneously.
3. In the Plot Color drop-down list, select Dye.
4. Click = (Show a legend for the plot).
Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
5. Observe the ROX dye signal. In the example experiment, the ROX dye signal
remains constant throughout the PCR process, which indicates typical data.
Notes
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Chapter 5 Analyze the Experiment E

View the Multicomponent Plot

6. Observe the FAM dye signal. In the example experiment, the FAM dye signal
increases throughout the PCR process, which indicates normal amplification.

Multicomponent Plot <| View Plate Layout T oW werraste W‘ 2a
Plot > SelectWells With |- Setecttem - v |[ S |
| B | showinwells ¥ Visw Legand I I B I [ I
Save current setings as the default

[‘1@‘— 1 [ 23] 4 sa]6 7 [ 8a]sa 10

4

i PP PP
4,500,000
4,000,000 : EEIEEIEEIE

S

3,500,000
c 2b
3,000,000
% 2,500,000 ) 0
% 2,000,000 |-
1,500,000 E
5 -
6 F
o
a 2 4 B B 10 12 14 16 18 N0 2 4 ¥ 2B N L M ¥ B L £ G
Cycle -
Lagerd H
M ROX [ TAMRA I FAM
Wells: [I] 6 Unknown [E]] 15 Standard [1] 3 Negative Control 72 Emply
7. Select the negative control wells one at a time and check for amplification. In the
example experiment, there is no amplification in the negative control wells.
i > SelectWells With: |- Selecthem- v - Celeciien |
Pmtcmur
Save current sefings as the default
B =
Multicomponent Plot I
4,500,000
s : IEIIEIIEIIE
3,500,000 [
c
3,000,000
% 2,500,000 ; D
% 2,000,000 I
1,500,000 E
1.000.0017 [
F
7 74500.0{)0
a
0 2 4 8 & 10 12 ¥ 18 18 N0 X2 A X W N R M B B L0 oL G
Cycle |
Legernd H
{- ROX TAMRA HH FAM
wells: [ 6 Unknown [E] 15 Standard [1] 3 Negative Control 72 Empty
Notes
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ﬂ Chapter 5 Analyze the Experiment

View the Raw Data Plot

Analysis When you analyze your own standard curve experiment, look for:

Guidelines

» Passive reference — The passive reference dye fluorescence level should remain

relatively constant throughout the PCR process.

Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

Any irregularities in the signal — There should be no spikes, dips, and/or sudden
changes in fluorescence.

Negative control wells — There should be no amplification in the negative control
wells.

For More For more information on the Multicomponent Plot screen, open the 7500 Software Help
Information by clicking @) or pressing F1.

View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence (not normalized) for each
optical filter for the selected wells during each cycle of the real-time PCR.

About the 1In the standard curve example experiment, you review the Raw Data Plot screen for a
Example stable increase in signal (no abrupt changes or dips) from the appropriate filter.

Experiment

View the Raw
Data Plot

Notes

1. In the navigation pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of

the plate layout in the View Plate Layout tab.

. Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

The legend displays the color code for each row of the reaction plate. In the example
shown below, Row A is red, Row B is yellow/green, Row C is green, and so on.

. Click-drag the Show Cycle pointer from cycle 1 to cycle 40. In the example

experiment, there is a stable increase in signal from filter 1, which corresponds to
the FAM™ dye filter.
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Chapter 5 Analyze the Experiment E
View the Raw Data Plot

Raw Data Plot
3

B RHEE

Raw Data Plot

4,500,000
4,000,000
3,500,000
3000800

# 2500000 [N %

2

=

£ 2000000
1,500,000

1.000.000

500,000

o

Filter

Legend

A B Mc Mp Me Hf Hc HH

Options

Show Cycle 40 - u | 4
e e L o o ¥
1 10 20 30 10

The filters are:

Filter 1 2 3 4 5
e FAM™ dye e JOE™dye ¢ TAMRA™dye | ¢ ROX™dye | Cy5®dye
Dye e SYBR®Green | e VIC®dye | ¢ NED™dye ¢ Texas Red®
dye e Cy3®dye dye

Analysis When you analyze your own standard curve experiment, look for the following in each
Guidelines filter:

* Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot screen, open the 7500 Software Help by
Information clicking g) or pressing F1.

Notes
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Chapter 5 Analyze the Experiment
View the Raw Data Plot
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Appendix A

“ Alternate Experiment Workflows

This appendix covers:

B Advanced Setup Workflow. . ... ... 98
B QuickStart Workflow . . ... .. .. . 100
B Template Workflow . ...... ... .. . i 102
B Export/Import Workflow . ...... .. .. .. . 104

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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n Appendix A Alternate Experiment Workflows

Advanced Setup Workflow

Advanced Setup Workflow

Notes

98

When you create an experiment using Advanced Setup in the 7500 software, you can set
up the experiment according to your own design.

1. Double-click g (7500 software) or select Start » All Programs »

Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

. In the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

3. To set up a new experiment:

a. Click Experiment Properties (default), enter the experiment name, then

select the experiment properties.

b. Click Plate Setup:
Experiment Type Action
Genotyping Define the SNP assays, then assign them to wells in the

reaction plate.

All other experiments Define the targets, then assign them to wells in the
reaction plate.

c. Click Add Biological Group to create biological replicates and assign
replicates to samples for each biological group in the reaction plate.

d. Click Run Method, review the reaction volume and thermal profile, then

edit as needed.

e. Click Reaction Setup, review the components and calculated volumes for

the PCR reactions, then edit as needed.

f. (Optional) Click D Materials List, review the list of materials, then order
the materials you need to prepare the reaction plate.
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Appendix A Alternate Experiment Workflows “
Advanced Setup Workflow

4. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
Standard curve b. Sample dI|Lj|tIO.nS. .
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative Cy a. Template.
Genotyping b. Samp!e dllultlons.
c. Reaction mix.
Presence/absence d. Reaction plate.

5. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

6. Analyze the data:
Open the experiment in the 7500 software.

a.
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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n Appendix A Alternate Experiment Workflows
QuickStart Workflow

QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the
instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
Standard curve b. Sample dI|Lj|tIO.nS. .
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative Cy a. Template.
Genotyping b. Samp!e dllultlons.
c. Reaction mix.
Presence/absence d. Reaction plate.

2. QuickStart the experiment:

a. Double-click g (7500 software) or select Start » All Programs »
Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.
b. In the Home screen, click 2Q QuickStart.

c. Select the Experiment Properties tab (default), enter the experiment name,
then select the experiment properties.

d. Select the Run Method tab, review the reaction volume and thermal profile,
then edit as needed.

3. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

Notes

100 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
Experiments



Appendix A Alternate Experiment Workflows “
QuickStart Workflow

4. Inthe 7500 software, complete the plate setup:

Experiment Type Select and complete the...

Genotyping a. Define SNP Assays and Samples tab.
b. Assign SNP Assays and Samples tab.

All other experiments a. Define Targets and Samples tab.
b. Assign Targets and Samples tab.

5. Analyze the data:
a. Open the experiment in the 7500 software.
b. In the navigation pane, click Analysis.

If the data are not analyzed, click Analyze.

o

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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n Appendix A Alternate Experiment Workflows
Template Workflow

Template Workflow

You can use a template to create a new experiment. Templates allow you to create many
experiments with the same setup information.

Createa 1. Double-click 3 (7500 software) or select Start » All Programs » Applied
Template Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 98).

3. Select File » Save As Template.
4. Enter a file name, select a location for the template, then click Save.

5. Click &I Close.

Create an 1. In the Home screen, click Template.

Experiment with a
Template Note: If you do not see the Template icon, click the arrow beneath the Design

Wizard icon to expand the Set Up menu.

2. Locate then select the template you created in steps 1 through 5 above, then click
Open. A new experiment is created using the following setup information from the
template:

» Experiment properties
* Plate setup
* Run method

» Reaction setup

3. (Optional) If you want to modify the experiment, use Advanced Setup (see
page 98).

4. Click [ Save, enter a file name, then click Save to save the experiment.

Notes
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Template Workflow

5. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
Standard curve b. Sample dI|Lj|tIO.nS. .
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative Cy a. Template.
Genotyping b. Samp!e dllultlons.
c. Reaction mix.
Presence/absence d. Reaction plate.

6. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

7. Analyze the data:
Open the experiment in the 7500 software.

a.
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Export/Import Workflow

Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported
from another experiment. Only reaction plate setup data are exported and imported.

Export Setup 1. Double-click 3 (7500 software) or select Start » All Programs »
Data Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2) or
Advanced Setup (see page 98).
3. Seclect File » Export.

4. Select the Export Properties tab (default), then:
. Select Setup.

a
b. Select One File in the drop-down list.

o

Enter a name, then select a location for the export file.

d. Select [£] (*.txt) in the File Type drop-down list.

IMPORTANT! You cannot export *.xml files.

5. (Optional) Select the Customize Export tab, then select the appropriate options.
6. Click Start Export.

7. When prompted, click Close Export Tool.

Create an  You can import plate setup data from an exported text file (*.txt) to complete the reaction
Experiment with plate setup data for your experiment.
an Exported Text
File IMPORTANT! Be sure the exported text file you select contains only reaction plate setup
data and that the experiment types match.

1. Import the reaction plate setup data from an exported text file:

a. Using a spreadsheet application (such as Microsoft® Excel software), open an
exported text file.

b. Replace the parameters of the text file as needed. When finished, save the file

as a tab-delimited text file.

Notes
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Export/Import Workflow

c. In the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

d. Create a new experiment or open an existing experiment.
e. Select File » Import.
f. Click Browse, locate and select the text file (*.txt), then click Select.

g. Click Start Import. The setup data from the exported text file is imported into
the open experiment.

Note: If your experiment already contains plate setup information, the software
prompts you to replace the plate setup with the data from the text file. Click Yes to
replace the plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 98).

3. Prepare the PCR reactions:

Experiment Type Prepare the...
Relative standard curve a. Template.
Standard curve b. Sample dI|L'ItIO.nS. .
c. Standard dilution series.
d. Reaction mix.
e. Reaction plate.
Comparative C; a. Template.
Genotyping b. Samp!e d||u‘t|ons.
c. Reaction mix.
Presence/absence d. Reaction plate.

4. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

a. Load the reaction plate into the instrument.
b. Start the run
c. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.

Notes
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“ Appendix A Alternate Experiment Workflows
Export/Import Workflow

5. Analyze the data:
Open the experiment in the 7500 software.

a.
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Advanced Setup

AIF
allele

allelic
discrimination plot

amplicon

amplification

amplification
efficiency (EFF %)

amplification plot

Glossary

In the 7500/7500 Fast system software, a feature that allows you to set up your experiment
according to your experiment design. Advanced Setup provides you with maximum
flexibility in the design and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The allelic discrimination plot is a
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
quantitation experiments, fluorescence data collected during amplification are displayed in
an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope close to
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

* Range of standard quantities — To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

* Number of standard replicates — To increase the precision of the standard quantities
and decrease the effects of pipetting inaccuracies, include replicates.

* PCR inhibitors — PCR inhibitors in the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed as:

» Baseline-corrected normalized reporter (ARn) vs. cycle
» Normalized reporter (Rn) vs. cycle
» Threshold cycle (Cy) vs. well
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amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

baseline

110

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage are
displayed in an amplification plot, and the data are used to calculate results. For genotyping
or presence/absence experiments, fluorescence data collected during the amplification
stage are displayed in an amplification plot, and the data can be used for troubleshooting.
See also cycling stage.

In the 7500/7500 Fast system, a PCR reaction mix that contains primers to amplify a target
and a reagent to detect the amplified target.

Identifier assigned by Applied Biosystems to TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays.

Data file on a CD shipped with each assay order. The file name includes the number from
the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

PCR reaction component in Applied Biosystems TagMan® Gene Expression Assays and
TaqMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify a
target and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a step
with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
e AutoDelta off: A

An analysis setting in which the software calculates the baseline start and end values for the
amplification plot. You can apply the automatic baseline setting to specific wells in the
reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (Cy). See also threshold cycle (CT).

In the amplification plot, a line fit to the fluorescence levels during the initial stages of PCR,
when there is little change in fluorescence.
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baseline-corrected
normalized reporter
(ARN)

biological replicates

blocked IPC

o
calibrator
chemistry

comparative C;
(AAC;) method

custom dye

cycle threshold

cycling stage

Glossary

The magnitude of normalized fluorescence generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence generated by the reporter at each cycle during the PCR amplification. In
the ARn vs. Cycle amplification plot, ARn is calculated at each cycle as:

ARn (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence generated by the reporter between the pre-PCR read and the
post-PCR read. In the allelic discrimination plot (genotyping experiments) and the
presence/absence plot (presence/absence experiments), ARn is calculated as:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See also normalized reporter (Rn).

Reactions that contain identical components and volumes, but evaluate separate samples of
the same biological source (for example, samples from three different mice of the same
strain, or separate extractions of the same cell line or tissue sample).

See also technical replicates.

In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks
amplification of the internal positive control (IPC). In the 7500/7500 Fast system software,
the task for the IPC target in wells that contain IPC blocking agent. See also negative
control-blocked IPC wells.

See threshold cycle (CT).
See reference sample.
See reagents.

Method for determining relative target quantity in samples. With the comparative Cy
(AAC;) method, the 7500/7500 Fast system software measures amplification of the target
and of the endogenous control in samples and in a reference sample. Measurements are
normalized using the endogenous control. The software determines the relative quantity of
target in each sample by comparing normalized target quantity in each sample to
normalized target quantity in the reference sample.

Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in
experiments on the 7500/7500 Fast system. When using custom dyes, the custom dye
should be added to the Dye Library and a custom dye calibration performed.

See threshold cycle (CT).

In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification
stage. For cycling stages, you can enable AutoDelta settings. See also amplification stage.
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Glossary

data collection

delta Rn (ARnN)

derivative reporter
(-Rn)

Design Wizard

diluent

Diluted Sample
Concentration (10X
for Reaction Mix)

dilution factor
dissociation curve
EFF%

endogenous control

endpoint read

experiment

112

A process during the instrument run in which an instrument component detects fluorescence
data from each well of the reaction plate. The instrument transforms the signal to electronic
data, and the data are saved in the experiment file. In the 7500/7500 Fast system software,
a data collection point is indicated by an icon in the thermal profile:

* Data collection on:

* Data collection off:
See baseline-corrected normalized reporter (DRn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn”) vs. temperature melt curve, the
derivative reporter signal is displayed in the y-axis.

A feature in the 7500/7500 Fast system software that helps you set up your experiment by
guiding you through best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the 7500/7500 Fast system software, a field displayed on the Sample Dilution
Calculations tab of the Reaction Setup screen. For this field, enter the sample concentration
you want to use to add to the reaction mix for all samples in the experiment. “10X for
Reaction Mix” indicates that the software assumes the sample or standard component of the
reaction mix is at a 10X concentration. For example, if the diluted sample concentration is
50.0 ng/uL (10X), the final sample concentration in the reaction is 5 ng/uL (1X).

See serial factor.
See melt curve.
See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levels in all samples you are testing.
Endogenous controls are used in relative standard curve and comparative C; (AAC)
experiments to normalize fluorescence for the target you are quantifying. Housekeeping
genes can be used as endogenous controls. See also housekeeping gene.

See post-PCR read.

Refers to the entire process of performing a run using the 7500/7500 Fast system, including
setup, run, and analysis. The types of experiments you can perform using the
7500/7500 Fast systems:

* Quantitation - standard curve

* Quantitation - relative standard curve

* Quantitation - comparative C (AACy)

* Melt curve

* Genotyping

* Presence/absence
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experiment name

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent
IPC+
made-to-order

assays

manual baseline

Glossary

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

The type of experiment you are performing using the 7500/7500 Fast system:

+ Standard curve

» Comparative C (AACy)

+ Relative standard curve

* Melt curve (not available in the Design Wizard)
* Genotyping

* Presence/absence

The experiment type you select affects the setup, run, and analysis.

Oligonucleotide that flanks the 5” end of the amplicon. The reverse primer and the forward
primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

A gene that is involved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the target
is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay
setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assays that have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (IPC). In the
7500/7500 Fast system software, the task for the IPC target in wells that contain the IPC
and do not contain IPC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).

See negative control-IPC wells.
TaqMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control

specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the amplification
plot. You can apply the manual baseline setting to specific wells in the reaction plate.

manual C; An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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melt curve

melt curve stage
melting temperature
(Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control
(NTC)

nonfluorescent
quencher-minor

groove binder (NFQ-
MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier
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A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate
the melting temperature (Tm) of the target or can identify nonspecific PCR amplification.
In the 7500/7500 Fast system software, you can view the melt curve as normalized reporter
(Rn) vs. temperature or as derivative reporter (—Rn”) vs. temperature. Also called
dissociation curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the 7500/7500 Fast system software, the task for targets or SNP assays in wells that
contain water or buffer instead of sample. No amplification of the target should occur in
negative control wells. Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of sample
in the PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked. Previously
called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).

Molecules that are attached to the 3" end of TagMan® probes. When the probe is intact, the
nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence.
Because the NFQ does not fluoresce, it produces lower background signals, resulting in
improved precision in quantitation. The minor groove binder (MGB) increases the melting
temperature (Tm) without increasing probe length. It also allows the design of shorter
probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence from the reporter dye normalized to the fluorescence of the passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.
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passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix

primer/probe mix

pure dye

quantitation method

quantity

quencher

Glossary

A dye that produces fluorescence. Because the passive reference signal should be consistent
across all wells, it is used to normalize the reporter dye signal to account for non-PCR
related fluorescence fluctuations caused by minor well-to-well differences in
concentrations or volume. Normalization to the passive reference signal allows for high
data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In the
7500/7500 Fast system, the grid contains 8 rows and 12 columns.

In the 7500/7500 Fast system software, you can use the plate layout as a selection tool to
assign well contents, to view well assignments, and to view results. The plate layout can be
printed, included in a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard curve
is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the 7500/7500 Fast system software, the task for the SNP assay in wells
that contain a sample with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the allelic discrimination plot and used to make allele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also
called endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended. Fluorescence
data collected during the pre-PCR read can be used to normalize fluorescence data collected
during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.

PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In 7500/7500 Fast systems, there are three types of quantitation methods: standard
curve, relative standard curve, and comparative C; (AACy).

In quantitation experiments, the amount of target in the samples. Absolute quantity can refer
to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-difference
between normalized quantity of target in the sample and normalized quantity of target in the
reference sample.

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from emitting
fluorescence while the probe is intact. With TagMan® reagents, a nonfluorescent quencher-
minor groove binder (NFQ-MGB) can be used as the quencher. With SYBR® Green
reagents, no quencher is used.
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QuickStart

R2 value

ramp

ramp speed

raw data plot

reaction mix

reagents

real-time PCR

reference sample

refSNP ID

regression
coefficients
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A feature in 7500/7500 Fast systems that allows you to run an experiment without entering
plate setup information.

Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C data points from the standard reactions. A value of 1.00 indicates a perfect fit
between the regression line and the data points.

The rate at which the temperature changes during the instrument run. For the melt curve
step, the ramp can also be defined as a temperature increment. In the graphical view of the
thermal profile, the ramp is indicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available ramp
speeds include fast and standard.

* For optimal results using the fast ramp speed, Applied Biosystems recommends using
TagMan® Fast reagents in your PCR reactions.

* For optimal results using the standard ramp speed, Applied Biosystems recommends
using standard reagents in your PCR reactions.

IMPORTANT! TagMan Fast reagents are not supported for genotyping or
presence/absence experiments.

A plot of raw fluorescence (not normalized) for each optical filter.

A solution that contains all components to run the PCR reaction, except for the template
(sample, standard, or control).

The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the 7500/7500 Fast systems:

+ TagMan® reagents
+ SYBR® Green reagents
* Other reagents

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping or
presence/absence experiments.

In relative standard curve and comparative C; (AACy) experiments, the sample used as the
basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National Center
for Biotechnology Information (NCBI). The refSNP ID can be used to search the Applied
Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called an rs
number.

Values calculated from the regression line in standard curves, including the R2 value, slope,
and y-intercept. You can use the regression coefficients to evaluate the quality of results
from the standards. See also standard curve.
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regression line

reject well

relative standard
curve method

replicate group
replicates

reporter
reverse primer
reverse
transcriptase

Rn

ROX™ dye

rs number

run method

sample

Sample DNA (10X)

Glossary

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m [log (Qty)] +b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard curve
method, the 7500/7500 Fast system software measures amplification of the target and of the
endogenous control in samples, in a reference sample, and in a standard dilution series.
Measurements are normalized using the endogenous control. Data from the standard
dilution series are used to generate the standard curve. Using the standard curve, the
software interpolates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

A set of identical reactions in an experiment.

See technical replicates or biological replicates.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dye is attached to the 5" end. If you are using SYBR® Green reagents, the reporter

dye is SYBR® Green dye.

An oligonucleotide that flanks the 3” end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR reaction
to perform 1-step RT-PCR.

See normalized reporter (Rn).

A dye supplied by Applied Biosystems and precalibrated on the 7500/7500 Fast systems.
ROX dye is used as the passive reference.

See refSNP ID.

Definition of the reaction volume and the thermal profile for the 7500/7500 Fast instrument
run.

The template that you are testing.

In the 7500/7500 Fast system software, a reaction component displayed on the Reaction
Mix Calculations tab of the Reaction Setup screen. The software assumes the sample DNA
is added to the reaction mix at a 10X concentration. For example, if the reaction volume is
20 uL, the calculated volume of sample for 1 reaction is 2 uL.
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Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target
reaction

serial factor

series

slope

SNP

SNP assay

SNP Assay Library

region of interest
(ROI) calibration

stage

standard
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In the 7500/7500 Fast system software, a collection of samples. The Sample Library
contains the sample name and the sample color.

In the 7500/7500 Fast system software, a reaction component displayed on the Reaction
Mix Calculations tab of the Reaction Setup screen. The software assumes the sample or
standard is added to the reaction mix at a 10X concentration. For example, if the reaction
volume is 20 pL, the calculated volume of sample or standard for 1 reaction is 2 pL.

In genotyping experiments, the combination of which sample to test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantitation experiments, the combination of which sample to test and which target to
detect and quantify in one PCR reaction. In the Design Wizard, you can detect and quantify
only one target in one PCR reaction. Use Advanced Setup to detect and quantify more than
one target in one PCR reaction.

In the 7500/7500 Fast system software, a numerical value that defines the sequence of
quantities in the standard curve. The serial factor and the starting quantity are used to
calculate the standard quantity for each point in the standard curve. For example, if the
standard curve is defined with a serial factor of 1:10 or 10X, the difference between any 2
adjacent points in the curve is 10-fold.

See standard dilution series.

Regression coefficient calculated from the regression line in the standard curve. The slope
indicates the PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See also amplification efficiency (EFF%) and regression line.

Abbreviation for single nucleotide polymorphism. The SNP can consist of a base difference
or an insertion or deletion of one base.

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP
and two probes to detect different alleles.

In the 7500/7500 Fast system software, a collection of SNP assays to add to genotyping
experiments. The SNP assays in the library contain the SNP assay name, SNP assay color,
and for each allele, the allele name or base(s), reporter, quencher, and allele colors. The SNP
assays in the library may also contain the assay ID and comments about the SNP assay.

Type of 7500/7500 Fast system calibration in which the system maps the positions of the
wells in the sample block. ROI calibration data are used so that the software can associate
increases in fluorescence during a run with specific wells in the reaction plate.

In the thermal profile, a group of one or more steps. There are three types of stages: holding
stage (including pre-PCR read and post-PCR read), cycling stage (also called amplification
stage), and melt curve stage.

Sample that contains known standard quantities. Standard reactions are used in quantitation
experiments to generate standard curves. See also standard curve and standard dilution
series.
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standard curve

standard curve
method

standard dilution
series

standard quantity

starting quantity

Glossary

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C values from the standard reactions plotted against
standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the standard
curve reactions are used to generate the standard curve. The standard curve is defined
by the number of points in the dilution series, the number of standard replicates, the
starting quantity, and the serial factor. See also standard dilution series.

Method for determining absolute target quantity in samples. With the standard curve
method, the 7500/7500 Fast system software measures amplification of the target in
samples and in a standard dilution series. Data from the standard dilution series are used to
generate the standard curve. Using the standard curve, the software interpolates the absolute
quantity of target in the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution series is prepared by serially diluting
standards. For example, the standard stock is used to prepare the first dilution point, the first
dilution point is used to prepare the second dilution point, and so on. In the 7500/7500 Fast
system software, the volumes needed to prepare a standard dilution series are calculated by
the number of dilution points, the number of standard replicates, the starting quantity, the
serial factor, and the standard concentration in the stock. See also standard curve.

A known quantity in the PCR reaction.

* In standard curve experiments, the quantity of target in the standard. In the
7500/7500 Fast system software, the units for standard quantity can be for mass, copy
number, viral load, or other units for measuring the quantity of target.

* Inrelative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining a standard curve in the 7500/7500 Fast system software, corresponds to the
highest or lowest quantity.

step A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status.

SYBR® Green PCR reaction components that consist of two primers designed to amplify the target and

reagents SYBR® Green dye to detect double-stranded DNA.
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system dye

TagMan® reagents

target

target color

Target Library

task

technical replicates
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Dye supplied by Applied Biosystems and precalibrated on the 7500/7500 Fast system.
Before you use system dyes in your experiments, make sure the system dye calibration is
current in the Instrument Maintenance Manager.

System dyes of the 7500/7500 Fast system include:
« FAM" dye
+ JOE™ dye
+ NED™ dye
« ROX™ dye
+ SYBRP® Green dye
« TAMRA™ dye
+ VIC® dye
* CY3dye
* CYS5dye
+ TEXAS RED® dye

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the 7500/7500 Fast system software, a color assigned to a target to identify the target in
the plate layout and analysis plots.

In the 7500/7500 Fast system software, a collection of targets to add to experiments. The
targets in the library contain the target name, reporter, quencher, and target color. The target
in the library may also contain comments about the target.

In the 7500/7500 Fast system software, the type of reaction performed in the well for the
target or SNP assay. Available tasks:

* Unknown

* Negative Control

 Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

+ [PC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)

Identical reactions that contain identical components and volumes and evaluate the same
sample.

See also biological replicates.
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template

thermal profile

threshold

threshold cycle (C,)

Tm

unknown

unknown-IPC wells

Glossary

In the Design Wizard of the 7500/7500 Fast system software (and in QuickStart for
quantitation experiments), the type of nucleic acid to add to the PCR reaction. The
recommended template varies according to experiment type:

* Quantitation experiments (standard curve, relative standard curve, and comparative
C;) — cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materials list.

* Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
» Presence/absence experiments - DNA

For presence/absence experiments, Applied Biosystems recommends adding DNA
templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection points
for all steps and stages of the 7500/7500 Fast instrument run.

1. In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic CT) or can be set manually (see manual CT).

2. In presence/absence experiments, the level of fluorescence above which the
7500/7500 Fast system software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the amplification
plot.

See melting temperature (Tm).

In the 7500/7500 Fast system software, the task for the target or SNP assay in wells that
contain the sample you are testing:

* In quantitation experiments, the task for the target in wells that contain a sample with
unknown target quantities.

* In genotyping experiments, the task for the SNP assay in wells that contain a sample
with an unknown genotype.

+ In presence/absence experiments, the task for the target in wells that contain a sample
in which the presence of the target is not known.

In presence/absence experiments, wells that contain a sample and internal positive control
(IPC).

y-intercept In the standard curve, the value of y where the regression line crosses the y-axis. The
y-intercept indicates the expected threshold cycle (C;) for a sample with quantity equal to 1.
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I-step RT-PCR 8, 23, 24, 31, 36
2-step RT-PCR 8, 23, 24
7500/7500 Fast system
consumables 4
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filters 3, 95
reagents 9
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Advanced Setup 10, 11, 23, 29, 53, 98
alternate experiment workflows. See workflows.
amplification efficiency 27, 73
Amplification Plot screen

monitor during arun 61

view after a run 74
amplification plot, typical 78
AMPNC flag 89

analysis screens
Amplification Plot screen 74
Multicomponent Plot screen 92
Multiple Plots screen 70
navigation tips 69
QC Summary screen 88
Raw Data Plot screen 94
Standard Curve screen 71
Well Table 81

analysis settings
advanced 87
baseline 87
CT 87
flag 87
threshold 87
view 86

analyze experiment
analyze 68
for more information 73, 80, 83, 87, 89, 91, 94, 95
guidelines 69, 73, 78, 83, 87, 89, 91, 94, 95
omit wells 90
publish the data 83
view Amplification Plot screen 74
view analysis settings 86
view Multicomponent Plot screen 92
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view Raw Data Plot screen 94
view Standard Curve screen 71
view Well Table 81
workflow 66

Index

Applied Biosystems
contacting xi
customer feedback on documentation xi
Technical Support xi
Applied Biosystems 7500/7500 Fast Real-Time PCR
System. See 7500/7500 Fast system.

assumptions for using this guide viii
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BADROX flag 89
baseline
correct values 78
examples 80
manually adjust 87

BLFAIL flag 89
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CAUTION, description xii
chemical safety xvii, xviii
consumables
Also see materials required 4
supported 4
conventions
safety xii
conventions used in this guide viii
create new experiment 19
CT 83
CTFAIL flag 89
Custom assays 36

customer feedback, on Applied Biosystems
documents xi

D

DANGER, description xii

data
about data collection 2
example experiment 11, 68
publish 83
design experiment
create new 19
define experiment properties 20
define methods and materials 22
finish Design Wizard 40
for more information 21, 24, 25, 27, 30, 31, 36, 39,
42
guidelines 21, 23, 25, 27, 29, 31, 36, 39, 42
order materials 37
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review reaction setup 32 Help system, accessing xi

set up run method 30 HIGHSD flag 89

set up samples 28

set up standards 26 |

set up targets 24

workflow 18 IMPORTANT, description xii
Design Wizard installation category Xix

Experiment Properties screen 20 instrument operation, safety xvi

finish 40

Materials List screen 37 Inventoried assays 36

Methods & Materials screen 22

Reaction Setup screen 32 L

Run Method screen 30 library 31
Samples screen 28
Standards screen 26
Targets screen 24

load reaction plate 57

deviation, standard 79 M
documentation, related ix Made to Order assays 36
Materials List screen 37
E materials required 45, 47, 49, 52
electrical safety xix Methods & Materials screen 22
electromagnetic compatibility standards. monitor run
See EMC standards Amplification Plot screen 61

Run Method screen 62
moving and lifting, safety xvi
moving parts, safety xix

EMC standards xxi
ergonomics, safety xx
example experiment

analyze 66 MTP flag 89
description 12 Multicomponent Plot screen 92
design 18 Multiple Plots screen 70
name 20 multiplex PCR 8, 24
prepare 44
run 56
workflow 14 N
Experiment Properties screen 20 navigation tips
EXPFAIL flag 89 display multiple plots 70
Export/Import 11, 104 select wells 69
negative control, component of experiment 7
F NOAMP flag 89
NOISE flag 89
flag 83 NOSIGNAL flag 89
flags

notification settings 59

O

analysis settings 87
in standard curve experiments 89

G OFFSCALE flag 89

guidelines omit wells 90
analysis 69, 73, 78, 83, 87, 89, 91, 94, 95 online Help. See Help system
chemical safety xviii order materials 37
design 21, 23, 25, 27, 29, 31, 36, 39, 42 other fluorescent-based reagents 10
preparation 46, 48, 50, 53 OUTLIERRG flag 89
run 60

outliers. See omit wells.
overvoltage category (rating) xix

H

hazard icons. See safety symbols, on instruments
hazard symbols. See safety symbols, on instruments
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physical hazard safety xix safety
prepare experiment before operating the instrument xvi
for more information 46, 50, 54 chemical xvii
guidelines 46, 48, 50, 53 conventions Xil
reaction mix electrical xix
prepare 49 ergonomic Xxx

reaction plate 51 guidelines xviii . .
sample dilutions 45 instrument operation xvi .
standard dilution series 47 moving and llftlpg mstrument. xvi
workflow 44 moving parts Xix.
moving/lifting xvi

prepare for run 57 physical hazard xix

print reaction setup instructions 35 repetitive motion xx
publish data 83 standards xxi

workstation xx
Q safety labels, on instruments xiv

safety standards xxi
safety symbols, on instruments xiii

sample dilutions
calculated volumes 34, 45

QC Summary screen 88
QuickStart 11, 100

R prepare 45
ramp speed 22, 23 Sample screen 28
Raw Data Plot screen 94 samples
reaction mix d.esig.n guidelines 29
calculated volumes 33 dilutions 45
volumes 49 sample reactions (unknowns) 53
. setup 28
reaction plate
layout 13, 40 select wells 69
load 57 singleplex PCR 8, 24
prepare 51 SPIKE flag 89
unload from the instrument 63 standard curve experiments
reaction plates 6 about 7
Reaction Setup screen 32 standard deviation, effect of threshold on 79
reagents standard dilution series
other fluorescent-based 10 calculated volumes 34
SYBR Green 9 component of experiment 7
TagMan 9 prepare 47
repetitive motion, safety xx standard vs. fast plates 6
replicate, component of experiment 7 standards
results, interpreting 67 component of experiment 7
run experiment d.esig.n guidelines 27
alerts 63 diluting 47
enable notification settings 59 EMC XXi_
for more information 63 safety xxi
guidelines 60 setup 26
monitor 61 Set Up Standards check box 24, 25
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